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Предисловие 
Благодарим Вас за приобретение этого изделия производства фирмы 
Topcon. Сведения, содержащиеся в этом руководстве (далее 
«руководстве») подготовлены фирмой Topcon Positioning Systems (далее 
«TPS») для владельцев изделий производства фирмы Topcon. Это 
руководство по эксплуатации было составлено для того, чтобы помочь 
использовать приемник при приведенных ниже условиях и положениях. 

 ПРИМЕЧАНИЕ 

Пожалуйста, внимательно ознакомьтесь с “Условиями и 
положениями”. 

Условия и положения 
ПРОФЕССИОНАЛЬНОЕ ИСПОЛЬЗОВАНИЕ - Это изделие 
предназначено для профессионального использования. Пользователь 
был профессиональным геодезистом или человеком, хорошо 
осведомленным о геодезических работах, что необходимо для понимания 
указаний по применению и безопасности перед началом работы, поверки 
или настройки прибора. 
При работе всегда требуется использовать защитную экипировку 
(защитную обувь, каску и т.д.). 

АВТОРСКИЕ ПРАВА - Все содержимое этого руководства является 
интеллектуальной собственностью фирмы TPS и защищено авторским 
правом. Все права сохранены. Запрещается использовать, получать 
доступ, копировать, хранить, отображать, использовать для создания 
составительских работ, продавать, изменять, публиковать, 
распространять, либо позволять третьей стороне получать доступ к 
любым рисункам, содержимому, информации либо данным из этого 
руководства без письменного разрешения TPS. Перечисленное выше 
содержимое может использоваться только для обеспечения 
использования приобретенного изделия. Информация и данные, 
содержащиеся в этом руководстве, являются ценным активом TPS, при 
создании которого были понесены существенные затраты труда, времени 
и денежных средств и являются плодом собственных усилий TPS по 
подборке, выбору и систематизации.
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Пользователю предоставляется персональное, неисключительное, не 
подлежащее передаче другому лицу разрешение использовать (лицензия) 
это ПО на указанных здесь условиях для одного изделия или одного 
компьютера. Вы не можете передавать или переуступать ПО или это 
разрешение без специального письменного разрешения TPS. Разрешение 
действует до его окончания. Вы можете прекратить действие лицензии в 
любой момент, уничтожив ПО и это руководство. TPS может прекратить 
действие лицензии в том случае, если Вы не выполняете любое из этих 
условий или положений. Вы должны уничтожить ПО и это руководство 
после того, как Вы прекратите использовать приемник. Все права 
собственности, авторские права и права на интеллектуальную 
собственность в ПО принадлежат TPS. Если Вы не согласны с 
вышеперечисленными условиями, предлагаем Вам вернуть не бывшие в 
употреблении руководство и ПО. 

КОНФИДЕНЦИАЛЬНОСТЬ - Это руководство, его содержимое и ПО 
(далее упоминаемые как «конфиденциальная информация») являются 
конфиденциальной и составляющей собственность информацией TPS. 
Принимая условия этого соглашения, Вы берете на себя обязательства 
сохранять эту информацию таким же образом, как наиболее ценные 
коммерческие секреты своей организации. Тем не менее, этот параграф 
не ограничивает Вас в предоставлении информации, нужной по роду 
деятельности Вашим работникам, занимающимся использованием и 
обслуживанием изделия. Таковые работники также обязаны не 
разглашать конфиденциальную информацию. В том случае, если вы 
будете вынуждены по закону раскрыть конфиденциальную информацию, 
Вы должны немедленно известить TPS с тем, чтобы мы могли 
ходатайствовать об охранном судебном приказе или соответствующих 
средствах правовой защиты. 

ИНТЕРНЕТ-САЙТ И ПРОЧИЕ ЗАЯВЛЕНИЯ - Данные условия и 
положения (в том числе лицензионное соглашение на ПО, ограничение 
гарантии и ограничения ответственности) не могут быть изменены 
заявлениями, опубликованными на Интернет сайте TPS (равно как и на 
любом другом Интернет сайте), в рекламных материалах и изданиях TPS, 
либо сделанные работником TPS или независимым подрядчиком TPS. 

МЕРЫ БЕЗОПАСНОСТИ - Неправильная эксплуатация изделия Topcon 
может быть причиной телесных повреждений, порчи собственности и/или 
отказа изделия. Ремонт изделия должен производиться исключительно в 
центрах гарантийного ремонта, авторизованных Topcon. Пользователям 
следует ознакомиться с предупреждениями о технике безопасности, 
приведенными в руководствах, приложенных к изделию, и строго им 
следовать.  
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РАЗНОЕ - Вышеупомянутые условия и положения могут быть в любой 
момент времени исправлены, изменены, заменены на другие либо 
отменены фирмой TPS. Вышеупомянутые условия и положения 
соответствуют и должны толковаться в соответствии с законами штата 
Калифорния без использования других юридических норм. 

Нормативные сведения 
В следующем разделе  содержится информация о соответствии данного 
изделия официальным нормативным требованиям. 

Соответствие требованиям FCC 
класса В 
Это устройство соответствует правилам FCC, Часть 15. Устройство в 
рабочем состоянии должно соответствовать следующим двум условиям: 

1. Данное устройство не должно вызывать вредных помех. 
2. Это устройство должно воспринимать любую помеху, включая 
помехи, которые могут вызвать нежелательные последствия при 
работе. 

Это оборудование было испытано и признано соответствующим по 
ограничениям для цифровых устройств класса В, в соответствии с 
правилами FCC, Часть 15. Эти ограничения предназначены для 
обеспечения обоснованной защиты от вредных помех при стационарной 
установке. Это оборудование генерирует, использует и может излучать 
электромагнитные волны в радиочастотном диапазоне, и если 
устанавливается не в соответствии с инструкциями, может вызвать 
помехи для радиосвязи. Однако нет никакой гарантии в том, что вредные 
помехи не возникнут в каждом конкретном случае. 
Если это оборудование вызывает помехи для радио или телевизионного 
приема, что может быть установлено включением и выключением 
аппаратуры, пользователь может попытаться устранить наведенные 
помехи одним или несколькими перечисленными ниже способами: 

• Изменить ориентацию или местоположение принимающей антенны. 

• Переместить оборудование от приемника. 

• Запитать оборудование и приемник от разных сетевых розеток.
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• Проконсультируйтесь с продавцом оборудования или опытным 
радиотехником для получения конкретных рекомендаций. 

 ОСТОРОЖНО 

Любые изменения или модификации, примененные к 
оборудованию без выраженного одобрения стороной, 
ответственной за соответствие этим требованиям, 
может аннулировать Ваше право эксплуатации этого 
оборудования. 

Требования к излучениям, 
предъявляемые в Канаде. 
Эта цифровая аппаратура класса В отвечает всем требованиям, которые 
содержатся в Канадских Правилах использования оборудования, 
вызывающего электромагнитные помехи. 

Соглашения, принятые в 
руководстве 
В этом руководстве использованы следующие обозначения: 

Обозначение  Описание  

File > Exit   Выберите пункт меню File (Файл), затем Exit  
    (Выход). 
Connection  Полужирным курсивным шрифтом выделено  
    название заголовков окон, в том числе диалоговых. 
Frequency  Курсивным шрифтом выделено название поля, 

 области или вкладки в диалоговом окне. 
Power:Mode Курсивным шрифтом через двоеточие дано 

название поля в области диалогового окна. 
Enter    Нажмите клавишу Enter (Ввод) клавиатуры. 

Примечание переводчика: названия отображаемых на английском языке 
элементов пользовательского интерфейса (названия пунктов меню, заголовков 
окон, кнопок, элементов списка и пр.) приведены в оригинальном виде, в скобках 
сразу за ними дан поясняющий перевод, пример см. выше.  
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СОВЕТ 

Дополнительная информация, которая может помочь Вам 
при обслуживании и настройке системы. 

 ПРИМЕЧАНИЕ 

Дополнительная информация о факторах, которые могут 
оказать влияние на работу системы, ее технические 
характеристики, результаты измерений или личную 
безопасность. 

 ОСТОРОЖНО 

Уведомление о том, что операция может оказать 
неблагоприятное воздействие на работу системы, ее 
технические характеристики, целостность данных 
или личное здоровье. 

 
ПРЕДУПРЕЖДЕНИЕ

Уведомление о том, что операция повредит систему, 
вызовет потерю данных, потерю гарантии или вред 
здоровью. 

 
ОПАСНОСТЬ 

ЭТО ДЕЙСТВИЕ НЕЛЬЗЯ ВЫПОЛНЯТЬ НИ ПРИ КАКИХ 
ОБСТОЯТЕЛЬСТВАХ.
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Глава 1  
Введение 
В этой главе приводится описание: 

• Приемника HiPer® XT (рис.1-1) 

• GPS и Вашего приемника 

• Основных функций приемника  

• Стандартного комплекта поставки и конфигураций 

• Составных частей приемника  

• Файла авторизации опций приемника (Option Authorization File, OAF) 

 
Рисунок 1-1. Приемник HiPer XT



Введение 

 HiPer XT- Руководство пользователя 1-2 

Общие сведения 
Приемник HiPer XT фирмы Topcon Positioning System представляет собой 
двухчастотный GPS+ приемник, разработанный как самый совершенный и 
компактный приемник для рынка геодезического оборудования. HiPer XT 
является многофункциональным, многоцелевым приемником, 
предназначенным для рынка высокоточных измерений. Под таким рынком 
подразумевают рынок оборудования, подсистем, компонентов и 
программного обеспечения, предназначенный для геодезической съемки, 
строительства, коммерческого картографирования, гражданской 
инженерии, сельскохозяйственных задач, требующих высокой точности, 
строительства наземных сооружений, управления сельскохозяйственной 
техникой, фотограмметрического картографирования, гидрографии и 
любых других задач, решаемых соответствующими средствами. 
Приемник HiPer XT может принимать и обрабатывать сигналы на несущих 
частотах диапазонов L1 и L2, что повышает точность определения 
координат пунктов наблюдения. Сочетание измерений по двум частотам и 
режима GPS+ у приемников HiPer XT обеспечивает технологию 
кинематической съемки в реальном времени, точно работающую как на 
коротких, так и на длинных базисах. Ряд других функций, в том числе 
подавление многолучевости и Co-Оp Tracking (слежение за спутниковыми 
сигналами GPS и ГЛОНАСС, при котором узлы слежения за обеими 
системами тесно взаимодействуют) обеспечивает хороший прием слабых 
сигналов, в том числе, и под плотной листвой. Приемник HiPer XT 
обеспечивает функциональность, точность, надежность и цельность, 
необходимые для быстрого и легкого сбора данных. 

Принцип действия 
Съемка, выполненная с помощью GPS-приемника, может обеспечить 
точное и надежное местоопределение, что является обязательным для 
проведения всех видов геодезических работ.  
В данном разделе приводятся общие сведения о GPS и работе 
приемника, чтобы помочь Вам понять и правильно применять GPS, что 
позволит Вам максимально эффективно использовать приемник. 

Общие сведения о GPS 
Глобальная система местоопределения (GPS), находящаяся под 
управлением министерства обороны Соединенных Штатов, является 
сетевой радионавигационной системой космического базирования. Эта 
система позволяет определять местоположение, скорость и точное время 
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любому пользователю, эксплуатирующему GPS-приемник на или вблизи 
земной поверхности, в любое время суток независимо от погодных 
условий. Глобальная навигационная спутниковая система ГЛОНАСС 
Министерства обороны Российской Федерации построена на том же 
принципе и обладает аналогичными возможностями. 
Для получения информации о текущем состоянии GPS посетите интернет-
сайты tycho.usno.navy.mil или www.navcen.uscg.gov. Состояние 
орбитальной группировки ГЛОНАСС отражено на интернет-сайте 
www.glonass-ianc.rsa.ru. 
Несмотря на большое количество технических отличий в реализации 
систем GPS и ГЛОНАСС, обе эти системы  включают в себя три главных  
компонента: 

• Космический сегмент – спутники GPS и ГЛОНАСС, обращающиеся 
по круговым орбитам высотой около 20 000 км, снабженные 
радиопередатчиками и высокоточными генераторами. Каждый из 
этих спутников передает свои орбитальные параметры 
(эфемериды), альманах системы (параметры орбиты всех 
остальных спутников), параметры коррекции времени бортовых 
часов и др.  

• Сегмент управления – наземные измерительные пункты, 
расположенные в различных частях Земли, отслеживающие 
спутники и закладывающие в них данные о поправках бортовых 
часов и обновленные эфемериды для обеспечения достоверности 
передаваемой со спутников информации. 

• Пользовательский сегмент – гражданские и военные пользователи, 
оснащенные GPS/ГЛОНАСС приемниками, используют измерения, 
выполненные по этим сигналам, для вычисления своего 
местоположения.  

Вычисление местоположения  
Как только приемник устанавливает слежение за сигналом со спутника, он 
начинает запись результатов измерений и прием разнообразной 
цифровой информации, передаваемой спутником (эфемерид, альманаха и 
т.д.). Для вычисления местоположения в приемниках используется 
следующая основная формула: 

скорость х время = расстояние, 
Здесь скорость является скоростью распространения радиоволн (т.е. 
скоростью света), а время – разность времени между моментом излучения 
сигнала и моментом его приема. 
Для вычисления трехмерных координат (широты, долготы и высоты) и 
синхронизации шкалы времени приемник должен отслеживать четыре 
спутника.  
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В случае работы по GPS и ГЛОНАСС одновременно, для определения 
абсолютных координат приемники должны отслеживать, по крайней мере, 
пять спутников. 
Для обеспечения отказоустойчивости при использовании спутников только 
GPS или только ГЛОНАСС, приемник должен отслеживать пятый спутник. 
Отслеживание шести спутников обеспечит отказоустойчивость при 
одновременном использовании обоих созвездий спутников. 
Как только произошел  захват спутниковых сигналов, приемник собирает 
данные эфемерид и альманаха, сохраняя информацию в своем 
энергонезависимом запоминающем устройстве. 

• Спутники GPS и ГЛОНАСС  передают данные эфемерид циклически, 
с периодом 30 секунд. 

• GPS спутники передают данные альманаха циклически с периодом 
12,5 минут; спутники ГЛОНАСС передают данные альманаха 
циклически с периодом 2,5 минуты. 

Местоопределение с помощью GPS 
Получение надежного и точного местоопределения возможно при 
соблюдении приведенных ниже условий: 

• Точность -  точность местоположения зависит, прежде всего, от 
геометрии спутников (характеризуется геометрическим фактором 
ухудшения точности – GDOP) и погрешностей измерения дальности 
до спутников.  

- Дифференциальный режим GPS (DGPS и RTK) в значительной 
степени подавляет погрешности, обусловленные прохождением 
сигналов в атмосфере и неточностью эфемерид, и устраняет 
искусственное зашумление спутниковых сигналов, применяемое 
министерством обороны США. 

- Чем больше спутников в поле зрения, чем сильнее их сигналы и 
чем меньше величина геометрического фактора, тем выше 
точность местоопределения. 

• Доступность – доступность спутников влияет на достоверность 
вычисленного местоположения. Чем больше видимых спутников, 
тем выше точность и достоверность вычисления координат 
местоположения. Естественные и искусственные объекты могут 
блокировать, прерывать и ослаблять сигналы, снижая число 
видимых спутников и ухудшая условия приема сигналов. 

• Целостность – отказоустойчивость позволяет полагать, что 
местоопределение определяется надежно и точно. 
Отказоустойчивость обеспечивается сочетанием перечисленных 
ниже факторов и методов: 
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- Автономный контроль целостности приемником (RAIM) 
позволяет определить отказавший спутник GPS или ГЛОНАСС и 
исключает данные этого спутника из вычислений 
местоположения.  

- Наличие не менее пяти видимых спутников при работе по 
одному из созвездий GPS или ГЛОНАСС; не менее шести 
спутников при работе по обоим созвездиям. 

- Широкозонная дифференциальная подсистема (WAAS, EGNOS 
и др.) вырабатывает и передает наряду с дифференциальными 
поправками (DGPS), данные о целостности информации 
(например, сообщения о состоянии спутников).  

- Достоверные данные эфемерид и альманаха.  

Выводы 
В данном кратком обзоре приведены только основы местоопределения по 
спутниковым навигационным системам (СНС) GPS и ГЛОНАСС. Более 
подробную информацию можно найти на интернет-сайте TPS 
(http://www.topconeurope.com).  

Функционирование приемника 
После того как подано напряжение питания и самотестирование 
закончилось, все 20 каналов приемника инициализируются и начинают 
отслеживать видимые навигационные спутники. Каждый канал приемника 
может быть использован для слежения за сигналами C/A – L1, P – L1 или 
P – L2. Большое число каналов приемника позволяет вести слежение 
одновременно за всеми видимыми спутниками GPS в любом месте и в 
любое время.  
Внутренняя навигационная спутниковая антенна, снабженная 
малошумящим усилителем, и высокочастотная часть приемника 
соединены коаксиальным кабелем. Принимаемый широкополосный сигнал 
преобразуется с понижением частоты, фильтруется, оцифровывается, и 
передается для обработки измерительным каналам. Центральный 
процессор приемника управляет слежением за спутниковыми сигналами. 
Как только в канале произошел захват сигнала, он демодулируется, и 
измеряются параметры сигнала (фазы кода и несущей). Из сигнала 
выделяется передаваемый спутником поток данных. 
После захвата приемником четырех и более спутников становится 
возможным произвести автономное (без привлечения дополнительной 
информации) местоопределение – т.е. вычислить координаты приемника в 
системе координат, используемой спутниковой навигационной системой и 
размер расхождения шкал времени, задаваемых системой и внутренним 
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генератором приемника. Вся эта информация сохраняется в памяти 
приемника, которая может быть позднее перегружена в компьютер и 
обработана с помощью специального программного обеспечения для 
постобработки. Если приемник используется в режиме RTK, то во 
внутреннюю память приемника также могут записываться данные для 
постобработки. Это позволяет оператору осуществить контрольную 
обработку результатов измерений, произведенных в полевых условиях в 
реальном времени. 
В зависимости от набора опций приемник обладает следующими 
возможностями: 

• Co-Оp Tracking (совместное слежение); 
• Подавление многолучевости; 
• Использование широкозонной подсистемы WAAS; 
• Настройка параметров контуров слежения за фазой и задержкой; 
• Двухчастотные режимы статической, кинематической, 

кинематической в реальном времени (RTK) и дифференциальной 
(DGPS) съемки; 

• Автоматическая запись данных; 
• Установка значения минимального угла возвышения; 
• Установка различных параметров съемки; 
• Статические и динамические режимы; 

Состав стандартного 
комплекта поставки 
HiPer XT поставляется либо в базовой комплектации, либо в комплекте 
для кинематической съемки в реальном времени (RTK). (см. также 
карточку комплектации). В состав комплекта входят: 

• один приемник HiPer XT и один из приемников  Legacy-E+, GB-500 
или GB-1000; 

ИЛИ 
Два приемника HiPer XT; 

• Вешка LitePole; 
• Штатив, трегер и адаптер; 
• Программное обеспечение Topcon Tools™ (приобретается 

отдельно); 
• Кабели, разъемы и адаптеры; 
• Руководство.



Состав стандартного комплекта поставки 

P/N 7010-0713 1-7 

Кабели 
Ниже перечислены стандартные кабели (см. рис. 1-2), включаемые в 
комплект поставки (p/n – каталожный номер): 

• Интерфейсный кабель RS232 (p/n 14-008005-03) – соединяет 
последовательный порт приемника и внешнее устройство (полевой 
контроллер или компьютер). 

• Кабель “приемник – SAE” (p/n 14-008016-03) – для подключения к 
приемнику внешнего источника питания с разъемом SAE или 
удлинителя кабеля питания «SAE-SAE». 

• Удлинитель кабеля питания «SAE-SAE», (p/n 14-008022-01).  

• Кабель “SAE-крокодил” (p/n 14-008025-01) - для подключения 
произвольного источника постоянного тока напряжением 12 В. 

• Кабель (p/n 14-008052-01 – для США или p/n 14-008054-01 – для 
Европы) – для подключения сетевого адаптера к сети переменного 
тока 220 В. 

• USB-кабель (p/n 14-008031-01) – для подключения внешнего 
устройства к приемнику через USB-порт. 

 
Интерфейсный RS232 Приемник – SAE Антенный 

 

  
Удлинитель кабеля 
питания «SAE-SAE» USB SAE-крокодил 

Рисунок 1-2. Кабели, входящие в стандартную поставку 



Введение 

 HiPer XT- Руководство пользователя 1-8 

Источник питания / зарядное 
устройство 
Блок источника питания / зарядного устройства (p/n 22-034101-01) 
используется для зарядки внутренних батарей при подключении к 
заземленной сетевой розетке; он может быть также использован как 
внешний источник питания (см. рис. 1-3). Этот блок преобразует сетевое 
напряжение переменного тока в напряжение постоянного тока, 
используемое для зарядки батарей и питания приемника.  

• входное напряжение – от 100 до 240 В переменного тока; 
• частота входного напряжения – от 50 Гц до 60 Гц; 
• выходное напряжение – 12 В пост. тока, 2,5 А (30 Вт). 

 
Рисунок 1-3. Источник питания / зарядное устройство 

Программное обеспечение  
Стандартное программное обеспечение, прилагаемое к приемнику, 
включает в себя перечисленные ниже программы производства фирмы 
Topcon, работающие в операционной системе Windows® на персональном 
компьютере: 

• PC-CDU Lite – программное обеспечение для настройки приемника. 
• FLoader – программа, используемая для загрузки встроенного в 

приемник программного обеспечения. 
• BTCONF – программа для настройки модуля беспроводной связи 

Bluetooth. 
• Modem-TPS - программа конфигурации радиомодема. 
• Topcon Tools – поставляется дополнительно; программное 

обеспечение постобработки фирмы Topcon. 
Программное обеспечение и информация о нем находятся также на 
интернет-сайте фирмы Topcon www.topconpositioning.com.  
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Устройство приемника 
Размеры приемника HiPer XT составляют 158,5мм в ширину, 173 мм в 
глубину, 113 мм в высоту; вес – примерно 1,78 кг. Конструкция приемника 
позволяет существенно сократить число подключаемых к нему кабелей, 
что увеличивает надежность и эффективность работы, особенно в 
мобильных приложениях.  
Приемник многофункционален и может быть сконфигурирован различным 
образом. Внутри корпуса предусмотрено пространство для несъемных, 
закрепленных на плате литий-ионных батарей, модуля беспроводной 
связи  Bluetooth, опционально поставляемого модуля GSM, и двух 
печатных плат формата Eurocard. Одна из них является приемником GPS, 
а другая – приемопередатчиком УКВ диапазона. 
Продолжительность работы в режимах базовой и подвижной станций 
приведена в таблице 1-2 на стр. 1-12. Технические характеристики 
приемника приведены в Приложении А.  

Внутренние узлы приемника 
Далее приводится описание составных частей (внутренних узлов) 
приемника HiPer XT. 

Антенна GPS+  
Внутренняя микрополосковая антенна принимает сигналы диапазонов L1, 
L2 систем GPS и ГЛОНАСС. 

Модуль Bluetooth 
Модуль состоит из высокочастотной части и процессора со 
специализированным программным обеспечением, и соответствует 
Bluetooth профилю SPP (serial point-to-point, последовательный точка-
точка). Используя этот модуль, HiPer XT может передавать файлы между 
приемником и любым другим устройством с беспроводной технологией 
Bluetooth, поддерживающим SPP, включая портативные переносные 
устройства и внешние контроллеры, адаптеры Bluetooth для PC-USB/RS 
портов, мобильные компьютеры и телефоны, iPAQ, PCMCIA-Bluetooth 
адаптеры и т.п. 
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С применением беспроводной технологии приемник Bluetooth способен 
вести прием и передачу на расстояние 10 м внутри помещений и 30-50 м 
вне них. 
Процессор и программное обеспечение модуля Bluetooth являются 
независимыми от платы приемника и платы питания. 

Радиомодем 
В приемнике предусмотрен встроенный УКВ приемопередатчик фирмы 
TPS с возможностью перестройки в пределах 20 МГц, шириной канала 
12,5/25 КГц и максимальной выходной мощностью 2 Вт. Модем базовой 
станции передает измерения по коду и фазе несущей вместе с 
информацией об опорной станции (т.е., ее местоположении) на модем 
подвижной станции. 
Частотный диапазон модема зависит от страны, в которой приемник 
предполагается использовать: для Северной Америки частотный диапазон 
составляет 450-470 МГц; при поставке во все остальные страны мира Ваш 
дистрибьютор проконсультирует Вас о разрешенных для использования 
диапазонах. 

 
СОВЕТ 

HiPer XT совместим с радиомодемами Pacific Crest. 

Модуль GSM 
Модуль GSM функционирует аналогично обычному сотовому телефону, 
при этом модем на подвижной станции инициирует соединение с 
модемом, находящимся на базовой станции. Если Вы хотите, чтобы Ваши 
приемники связывались по сети GSM, требуется предварительно 
заключить договоры с оператором и получить SIM-карты. Подробности Вы 
можете узнать у своего дилера. 
Модуль GSM монтируется на плату УКВ модема. 

 ПРИМЕЧАНИЕ 

Ваш продавец оборудования даст консультацию о 
заключении контракта с оператором связи. 
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Плата питания 
Внутренняя плата питания обеспечивает приемник питанием и зарядку 
батарей и, соответственно, соединена с приемником и батареями. Плата 
питания получает питание от внутренних батарей даже тогда, когда 
приемник отключен. Это обстоятельство позволяет производить зарядку 
внутренних батарей независимо от состояния приемника (выключен он 
или нет). Чтобы предотвратить разряд батарей при долговременном 
хранении, переведите приемник в режим сверхнизкого энергопотребления 
(подробно об этом написано в разделе “Режим сверхнизкого 
энергопотребления”, стр. 4-20). В этом режиме батареи разряжаться не 
будут. 
Процессор платы питания и его управляющая программа функционируют 
независимо от платы приемника. Для гарантии совместимости 
программного обеспечения платы GPS-приемника и питания должны 
загружаться программным обеспечением из одного пакета обновления 
встроенного ПО. 

Плата приемника GPS+ 
Приемник выполнен на плате Euro-112T, способной обрабатывать  
следующие сигналы: 

• GPS L1 или GPS L1/L2 

• GPS/ГЛОНАСС L1 или GPS/ГЛОНАСС L1/L2 
В таблице 1-1 перечислены возможные варианты комплектации этих плат. 

Таблица 1-1. Варианты плат Euro-112T в HiPer XT 
 

Модель Eurocard Возможные варианты 

Euro-112T (HGGDT) 

G: GPS L1 
GD: GPS L1/L2 
GG: GPS L1/ГЛОНАСС L1 
GGD: GPS/ГЛОНАСС L1/L2 

Приемник TPS, обладающий возможностью работы с WAAS, позволяет 
одновременно отслеживать два спутника WAAS. Для каждого спутника 
WAAS выделяется свой канал обработки сигнала.  
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Батареи 
Приемник снабжен двумя несъемными перезаряжаемыми литий-ионными 
батареями, установленными на плате питания приемника. Каждая из 
литий-ионных батарей блока выдает напряжение 7.4 В и имеет емкость 4 
А-ч. Блок из двух батарей, соответственно, обеспечивает номинальное 
напряжение 7.4 В и обладает емкостью 8 А-ч после полной зарядки.  
В табл. 1-2 приведена продолжительность работы приемника HiPer XT при 
полностью заряженных батареях в зависимости от режима работы УКВ 
радиомодема. 

Таблица 1-2. Время работы 
 

Режим работы радиомодема Продолжительность работы 

Включен режим передачи (1Вт). 11 часов 

Включен режим приема. 14 часов 

Режим ожидания. 13 часов 

Выключен. 16 часов 

Литий-ионные батареи, используемые в HiPer XT, после 500 циклов заряд-
разряд сохраняют не менее 98% первоначальной емкости. Эти батареи не 
имеют эффекта памяти и не нуждаются в полной разрядке перед 
зарядкой. 
Зарядное устройство (сетевой адаптер) также включено в стандартный 
комплект поставки. В приложении А приведены технические 
характеристики батарей. 

Внешние компоненты 
На внешних панелях корпуса HiPer XT размещены разъемы для 
подсоединения УКВ антенны, элементы пользовательского интерфейса, 
разъем питания и разъемы интерфейсных портов. 

Нижняя панель  
На нижней панели приемника HiPer XT нанесены серийный номер, 
каталожный номер изделия, тип приемника (базовый или подвижный) и 
показана точка относимости антенны (antenna reference point, ARP). 
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Защитный кожух антенны 
На рисунке 1-4 показаны компоненты защитного кожуха антенны: 

• Защитный кожух встроенной антенны GPS/ГЛОНАСС. 

• Антенный разъем УКВ приемопередатчика (по центру) – тип BNC. 

 
Рисунок 1-4. Защитный кожух антенны HiPer XT 

Передняя панель  
На рис. 1-5 на стр. 1-15 изображены компоненты передней панели 
приемника HiPer XT: 

• MINTER – Minimum INTERface: простой пользовательский интерфейс 
приемника, состоящий из трех кнопок и четырех трехцветных 
светодиодов. Описание и использование компонентов MINTER 
приведены в разделе “Использование MINTER” на стр. 4-2. 

• RESET (Перезапуск) – эта кнопка осуществляет «жесткую» 
перезагрузку платы приемника и платы питания. После нажатия на 
кнопку контроллеры, управляющие платами приемника и питания, 
перезагружаются, и устройство повторно запускается. Эта кнопка 
может быть использована для выхода из режима сверхнизкого 
энергопотребления или тогда, когда приемник не реагирует на 
команды. Подробно об этом написано в разделе “Использование 
MINTER” на стр. 4-2. 
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• Четыре последовательных порта: 
- Порт А используется для связи платы приемника с контроллером 
или другим внешним устройством. 

- Порт В используется для связи платы приемника со встроенным 
модулем Bluetooth внутри прибора, на переднюю панель не 
выведен. 

- Порт С используется для связи платы приемника со встроенным 
УКВ приемопередатчиком внутри прибора, на переднюю панель 
не выведен. 

- Порт D используется для связи платы приемника с внешними 
устройствами. 

• USB – используется для высокоскоростной передачи данных между 
приемником и внешним устройством. 

• PWR – входной порт питания, к которому подключается внешний 
источник питания (от +6 до + 28 В). Через этот порт производится 
зарядка встроенных батарей. 

• Метка для измерения наклонной высоты (Slant height measure mark, 
SHMM). 

 
Рисунок 1-5. Передняя панель HiPer XT
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Задняя панель 
На Рис. 1-6 представлены компоненты задней панели приемника HiPer XT. 

• Вентиляционный клапан  - уравнивает давление внутри приемника с 
внешним давлением. 

• Метка для измерения наклонной высоты 

 
Рисунок 1-6. Задняя панель HiPer XT 

Файл авторизации опций 
(OAF) 
Topcon Positioning Systems выпускает файлы авторизации опций (OAF) 
для того, чтобы пользователь получил возможность использовать 
приобретенные им опции. Файл авторизации опций (OAF) позволяет 
покупателям настраивать и конфигурировать приемник под выполнение 
конкретных задач, так что остается лишь приобрести необходимые опции. 
Перед отправкой приемника конечному потребителю продавец загружает 
в него OAF, в котором активизированы приобретенные Вами опции. При 
очистке энергонезависимого ОЗУ или перезагрузке приемника опции 
приемника не перезаписываются. 
OAF предоставляет возможность воспользоваться следующими видами 
функций (полный перечень доступных опций и функций уточните у 
продавца оборудования): 

• Частотный диапазон (стандартный- L1, дополнительный L2). 

• Память (стандартная 0 Мб; дополнительно – от 1 Мб до 128 Мб). 
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• Темп обновления данных (стандартно 1 Гц, дополнительно 5, 10 или 
20 Гц). 

• RTK на 1 Гц, 5Гц, 10 Гц и 20 Гц. 

• RTCM/CMR Вход/выход. 

• Маркер событий. 

• Co-op слежение. 

• Усовершенствованное подавление многолучевости. 

• Широкозонная дифференциальная подсистема (WAAS). 

• Автономный контроль целостности приемника (RAIM). 

• 1 PPS (один импульс в секунду; выход сигнала синхронизации). 
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Для заметок: 
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Глава 2  
Настройка 

В этой главе описываются процедуры настройки прибора: 

• Подключение приемника к источнику питания и контроль питания 
приемника. 

• Подключение приемника к компьютеру. 

• Настройка приемника. 

• Настройка MINTER. 

• Настройка УКВ приемопередатчика. 

• Настройка модуля Bluetooth. 

• Сбор альманаха. 
Перед началом работы с приемником HiPer XT проделайте следующее: 
1. Зарядите батареи. См. раздел “Подключение приемника к источнику 

питания” на стр. 2-2. 
2. Проведите настройку составных частей Вашего приемника. Смотрите: 

• “Подключение приемника к персональному компьютеру” на стр. 
2-10. 

• “Настройка приемника“ на стр. 2-15. 

• “Настройка пользовательского интерфейса MINTER” на стр. 2-18. 

• “Настройка радиомодема” на стр. 2-25. 

• “Настройка модуля Bluetooth” на стр. 2-41. 
3. Соберите альманах. См. раздел “Сбор альманахов” на стр. 2-46.
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Подключение приемника к 
источнику питания 
Вы можете запитать приемник от внутренних батарей, а также 
использовать внешние батареи или зарядное устройство. 

Внутренние батареи 
В таблице 2-1 приведена продолжительность работы приемника HiPer XT 
при полностью заряженных батареях в зависимости от режима работы 
УКВ модема. 

Таблица 2-1. Время работы 
 

Режим работы радиомодема Продолжительность работы 
Включен режим передачи (1Вт). 11 часов 
Включен режим приема. 14 часов 
Режим ожидания. 13 часов 
Выключен. 16 часов 

1. Для зарядки внутренних батарей: 
• Подстыкуйте кабель “приемник - SAE“ к разъему PWR на лицевой 

панели приемника. 
• К сетевому адаптеру подстыкуйте кабель “приемник - SAE“ и 

кабель для подключения сетевого адаптера к сети переменного 
тока. 

• Вставьте вилку кабеля для подключения сетевого адаптера к сети 
переменного тока в свободную розетку. Розетка должна быть 
оснащена надежным соединением с контуром заземления. 
Напряжение в сети должно лежать в пределах от 90 до 264 В 
переменного тока, частота в от 47 до 63 Гц. Сетевой адаптер 
потребляет ток до 1А при 110 В. Выход сетевого адаптера - 
постоянное напряжение 12 В, сила тока до 2,5 А (30 Вт). 

2. Нажмите клавишу RESET (Перезапуск) на лицевой панели приемника. 
Это обеспечит перевод приемника в “нормальный” режим, в котором 
заряд батарей будет производиться. В режиме сверхнизкого 
энергопотребления заряд внутренних батарей не производится 
(подробности изложены в разделе “Режим сверхнизкого 
энергопотребления” на стр. 4-20). 

3. Оставьте прибор заряжаться на всю ночь. Семичасовой цикл заряда 
позволяет зарядить батареи приблизительно на 90%. Полный заряд 
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батарей приемника требует примерно девять часов. Встроенный 
автоматический контроль не допустит перезаряда внутренних батарей. 

Скорость заряда зависит от настроек, установленных в областях Power 
(Питание) и Charger (зарядное устройство) вкладки General (Общие) 
диалогового окна Receiver Configuration (Настройка приемника), а также 
от того, включен или выключен приемник. Более подробная информация 
приведена в разделе “Управление питанием” на стр. 2-5. 
Литий-ионные батареи, используемые в HiPer XT, после 500 циклов заряд-
разряд сохраняют не менее 98% емкости. Эти батареи не имеют эффекта 
памяти и не нуждаются в полной разрядке перед зарядкой. 

Внешние батареи 
В дополнение к внутренним батареям Вы можете использовать приемник  
с внешними батареями (см. рис. 2-1 на стр. 2-4). Внешние батареи 
позволят Вам продолжить работу с приемником в случае, если внутренние 
батареи окажутся разряженными. Для этого требуется следующее: 

• Батарея 12 В, 2,3 А-ч. 

• Кабель – переходник от клемм батареи 12 В, 2,3 А-ч на SAE. 

• Кабель “приемник – SAE”. 

 ПРИМЕЧАНИЕ 

При использовании внешних батарей измените 
установку работы зарядного устройства на OFF (ВЫКЛ). 
В противном случае энергия, получаемая от внешних 
батарей, будет также использоваться для заряда 
внутренних батарей, что приведет к уменьшению 
времени работы. Более подробная информация по 
установкам режима зарядки приведена в разделе 
“Управление питанием” на стр. 2-5.  

1. Состыкуйте разъемы SAE кабелей “приемник – SAE” и кабеля-
переходника (см. выше)  

2. Подстыкуйте кабель “приемник - SAE“ к разъему PWR на лицевой 
панели приемника. 

3. Подстыкуйте кабель – переходник к клеммам батареи. 
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Одна внешняя батарея 12 В, 2,3 А-ч обеспечивает работу приемника с 
выключенным УКВ приемопередатчиком примерно в течение 7 часов и 5 
часов работы с включенным УКВ приемопередатчиком. 

 
Рисунок 2-1. Присоединенная к приемнику внешняя батарея. 

 

 
СОВЕТ 

Вы можете также использовать удлинитель кабеля питания 
“SAE-SAE” и кабель “SAE - крокодил” и запитать приемник от 
автомобильного аккумулятора. 

Зарядное устройство 
Зарядное устройство, используемое для зарядки внутренних батарей, 
может быть использовано также и для питания приемника. Зарядное 
устройство входит в комплект поставки приемника. 
1. Подстыкуйте кабель “приемник - SAE“ к разъему PWR на лицевой 

панели приемника. 
2. К сетевому адаптеру подстыкуйте кабель “приемник - SAE“ и кабель 

для подключения сетевого адаптера к сети переменного тока. 
3. Вставьте вилку кабеля для подключения сетевого адаптера к сети 

переменного тока в свободную сетевую розетку. Розетка должна быть 
оснащена надежным соединением с контуром заземления. Напряжение 
в сети должно лежать в пределах от 90 до 264 В переменного тока, 
частота в от 47 до 63 Гц. Сетевой адаптер потребляет ток до 1А при 
110 В. Выход сетевого адаптера - постоянное напряжение 12 В, сила 
тока до 2,5 А (30 Вт). 
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Включение и выключение 
приемника 
Для включения приемника нажмите на (примерно) полсекунды зеленую 
клавишу POWER (питание), а затем отпустите ее. 

 ПРИМЕЧАНИЕ 

Если приемник не включается, он, скорее всего, 
находится в режиме сверхнизкого энергопотребления. 
Подробности см. раздел ”Режим сверхнизкого 
энергопотребления” стр. 4-20. 

Для того чтобы выключить приемник, нажмите и удерживайте в нажатом 
состоянии клавишу POWER (зеленого цвета) на время от 1 до 4 секунд  
(пока не выключатся светодиоды STAT и REC). Эта задержка (около 1 
секунды) предотвращает ошибочное выключение приемника. 

Управление питанием 
Для управления питанием приемника следует использовать программное 
обеспечение Topcon PC-CDU. С полным описанием PC-CDU можно 
ознакомиться в Руководстве пользователя PC-CDU.  
Вызвать диалоговое окно для настройки питания приемника проделайте 
следующее: 
1. Подключите приемник к компьютеру. Описание этой процедуры 

приведено в разделе  «Подключение приемника к персональному 
компьютеру” на стр. 2-10. 

2. После подключения выберите пункт меню Configuration > Receiver 
(Установка > Приемник). 

3. В области Power (Питание) щелкните на выпадающем списке Mode 
(Режим) и выберите в нем нужный Вам источник питания (см. рис. 2-2 
на стр. 2-6). Поле Current Mode (Текущий режим) указывает источник 
питания, используемый в настоящий момент. 

• Auto – выбор источника питания производится автоматически. 

• Mix (смешанный)– приемник измеряет напряжение на всех 
доступных источниках питания и питается от источника питания с 
наибольшим напряжением.  

• Battery A – приемник питается от батареи А. 
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• Battery В – приемник питается от батареи В. 

• External – приемник питается от внешнего источника. 

 
Рисунок 2-2. Выбор Режима питания 

4. В области Charger (Зарядное устройство) щелкните на выпадающем 
списке Mode (Режим) и выберите в нем нужный режим зарядки (см. рис. 
2-3). Поле Current Mode (Текущий режим) указывает на заряжающуюся 
батарею: a, b или off (батареи не заряжаются). 
• Off – приемник не заряжает батареи.  
• Зарядка А – приемник должен заряжать только батарею А.  
• Зарядка В – приемник должен заряжать только батарею В.  
• Auto - приемник автоматически обнаруживает необходимость 

подзаряда и заряжает обе батареи. 

 
Рисунок 2-3. Выбор режима зарядного устройства 
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5. В области Power output modes (Режимы питания внешних устройств) 
щелкните на выпадающем списке Ports (Порты – разъемы на лицевой 
панели) и выберите в нем режим подачи напряжения питания на 
штырьки №1 разъемов последовательных портов (см. рис. 2-4):  
• On – включенный приемник на все последовательные порты 

подает напряжение питания. Если приемник выключен, то 
напряжение питания не подается. 

• Off – включенный приемник не подает напряжение питания.  
• Always - напряжение питания подается, даже если приемник 

выключен.  
6. В области Power output modes Slots (Режимы питания внутренних 

плат) щелкните по выпадающему списку Slots (Слоты  = гнезда для 
внутренних плат) и выберите в нем режим подачи напряжения 
питания на внутренние платы (см. рис. 2-4): 
• On – включенный приемник запитывает все слоты. 
• Off – включенный приемник напряжение питания на внутренние 

слоты не подает. 
• Always –все внутренние слоты будут запитаны даже при 

выключенном приемнике. 

 
Рисунок 2-4  Выбор режимов питания внешних устройств 

7. В области Voltages (Вольтметры) (см. рис. 2-5 на стр. 2-8) 
отображаются текущие значения напряжений:  
• External – внешнего источника питания. 
• On Board – выдаваемого платой питания. 
• Battery A – на батарее А.  
• Battery В – на батарее В.  
• Charger – на зарядном устройства при зарядке батарей. 
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Рисунок 2-5. Просмотр вольтметров 

8. Флажки области Turn on/off Slots (Вкл./Выкл. слот) позволяют подавать 
напряжение питания на соответствующий внутренний слот (см. рис. 2-
6). 

9. Флажок Enable Low Power Mode (Включить режим малого 
энергопотребления) позволяет перевести процессор приемника в 
режим малого потребления энергии (см. рис. 2-6).  

 
Рисунок 2-6. Установки режима питания 

10. Щелкните на кнопке Apply (Применить).  
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Зарядка внутренних батарей 
Для убыстрения зарядки батареи настройте один из следующих режимов: 

• Если приемник будет выключен. Power:Mode и Charger:Mode 
установите в Auto. Для установки этих параметров обратитесь к 
разделу ”Управление питанием” на стр. 2-5. 

• Если приемник будет включен. Установите Power:Mode в состояние 
External, а  Charger:Mode в Auto. 

1. Для зарядки внутренних батарей: 

• Подстыкуйте кабель “приемник - SAE“ к разъему PWR на 
лицевой панели приемника. 

• К сетевому адаптеру подстыкуйте кабель “приемник - SAE“ и 
кабель для подключения сетевого адаптера к сети переменного 
тока. 

• Вставьте вилку кабеля для подключения сетевого адаптера к 
сети переменного тока в свободную сетевую розетку. 

2. Нажмите клавишу RESET (Перезапуск) на лицевой панели приемника. 
Это обеспечивает переход приемника войдет в “нормальный” режим, в 
котором производится заряд батарей. В режиме сверхнизкого 
энергопотребления заряд внутренних батарей не производится 
(подробности изложены в разделе “Режим сверхнизкого 
энергопотребления” на стр.4-20). 

3. Оставьте прибор заряжаться на всю ночь. Семичасовой цикл заряда 
позволяет зарядить батареи приблизительно на 90%. Полный заряд 
батарей приемника требует примерно девять часов. Встроенный 
автоматический контроль не допустит перезаряда внутренних батарей. 

4. После окончания зарядки установите Power:Mode в Auto. 

 ПРИМЕЧАНИЕ 

Если Вы отключите кабель питания прежде, чем 
установите режим питания Power:Mode в состояние 
Auto, приемник выключится. Для того чтобы его 
включить, следует повторно подключить кабель 
внешнего питания.  
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Контроль состояния внутренних батарей 
Для проверки состояния внутренних батарей воспользуйтесь светодиодом 
BATT или программой Topcon PC-CDU.  
1. Индикация светодиода BATT: 

• Зеленый  – заряд батарей более 85%. 
• Оранжевый – заряд батарей от 15% до 85%. 
• Красный – заряд батарей менее 15%. 

2. Для просмотра напряжения на батареях через программу Topcon 
PC-CDU выберите один из перечисленных ниже пунктов меню: 

• Configuration > Receiver (Установка > Приемник) для вызова 
диалогового окна Receiver Configuration (Установки 
приемника).  

• Help > About (Помощь > О программе) для вызова диалогового 
окна About PC-CDU (О программе PC-CDU). 

Подключение приемника к 
персональному компьютеру 
Настройка приемника, работа с его файловой системой и техническое 
обслуживание производится с помощью программы PC/CDU, 
выполняющейся на IBM-PC совместимом персональном компьютере под 
управлением операционной системы Windows. Соединение с приемником 
можно установить по перечисленным ниже интерфейсам: 

• Bluetooth. 

• Кабель RS232. 

• USB кабель (на компьютер следует предварительно установить 
драйвер TPS USB). 

После соединения приемника и компьютера (по любому из указанных 
Выше интерфейсов) Вы сможете: 

• Настраивать приемник и его отдельные узлы. 

• Посылать команды на приемник. 

• Скачивать файлы из внутренней памяти приемника. 

• Загружать в приемник новое программное обеспечение (с 
использованием программы FLoader™), файлы OAF и файлы 
настроек.
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Установление беспроводного 
соединения 
В приемнике HiPer XT установлен модуль беспроводной связи Bluetooth, с 
его помощью можно передавать файлы между приемником и любым 
внешним устройством с Bluetooth, поддерживающим SPP, включая 
портативные переносные устройства и внешние контроллеры, адаптеры 
Bluetooth для PC-USB/RS портов, мобильные компьютеры и телефоны, 
iPAQ, адаптеры PCMCIA-Bluetooth и т.п. 

 ПРИМЕЧАНИЕ 

Изменение начальных установок порта В приемника 
нарушит связь Bluetooth. Начальными установками для 
порта В являются: 115200, 8, N, 1. 

Порядок соединения приемника и внешнего устройства незначительно 
меняется в зависимости от типа используемого внешнего устройства. В 
общем, процедура соединения следующая: 

 ПРИМЕЧАНИЕ 

Подробная информация об установлении соединения 
приводится в документации на устройство, оснащенное 
Bluetooth. 

1. Включите внешнее устройство с Bluetooth и приемник. Начальным 
режимом работы внешнего устройства, скорее всего, является Master 
(Ведущий); режим встроенного модуля Bluetooth приемника – Slave 
(Подчиненный). 

2. Задать внешнему устройству (Master) поиск приемника (Slave). 
3. Как только устройство Master обнаружит приемник, воспользуйтесь 

процедурой, описанной в документации к внешнему устройству для 
соединения его с приемником. 

4. Если внешним устройством является персональный компьютер, то 
после того, как соединение установится, продолжите работу, начиная с 
шага 1 из раздела “Установление соединения в программе PC-CDU“ на 
стр. 2-13. 
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Если соединение не устанавливается, прежде всего проверьте, чтобы на 
третий слот приемника подавалось напряжение питания, для этого: 
1. Соедините приемник и компьютер с помощью кабеля RS232 или 

кабеля USB и запустите программу PC-CDU. 
2. Выберите пункт меню Configuration > Receiver > General (Настройки 

> Приемник > Общие). 
3. В области Turn on/off Slots выставьте флажок Slot 3. 

Установление соединения через 
RS232 
1. Соедините последовательный порт Вашего компьютера (обычно, 

COM1) с последовательным портом A приемника кабелем RS232. 
2. Включите приемник и компьютер, нажав на их кнопки питания. 
3. Продолжите работу с шага 1 раздела “Установление соединения в 

программе PC-CDU” на стр. 2-13. 

Установление соединения через 
USB 
1. Соедините USB порт Вашего компьютера с USB портом приемника 

кабелем USB. 
2. Включите приемник и компьютер, нажав на их кнопки питания.  
3. Продолжите работу с шага 1 раздела “Установление соединения в 

программе PC-CDU” на стр. 2-13. 
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Установление соединения в 
программе PC-CDU 
Программа PC-CDU (Personal Computer - Control Display Unit, терминал 
управления на ПК) предназначена для управления приемником. Полное 
описание PC-CDU приводится в “Руководстве пользователя PC-CDU”. 
1. После установления соединения приемника и компьютера запустите на 

компьютере PC-CDU. Сразу после запуска программы ее главное окно 
примет вид, показанный на рис. 2-7. 

 
Рисунок 2-7. Главное окно PC-CDU 

Обратите внимание, что в нижнем левом углу состояние приемника 
отображается как Disconnected (Не подключен). 
2. Выберите пункт меню File > Connect (Файл > Соединить). 
3. В диалоговом окне Connection Parameters (Параметры 

интерфейсов) выберите указанные ниже параметры и щелкните на 
кнопке Connect (Соединить): 

• Для Bluetooth или RS232 интерфейсов (см. рис. 2-8 на стр. 2-14): 
- В области Connection Mode (Тип соединения) выберите 

вариант Direct (Прямое). 
- Выберите последовательный порт компьютера (обычно 

COM1, COM2 для соединения по RS232 и COM3, COM4 и т.д. 
для соединения Bluetooth) из выпадающего списка Port 
(Порт). 



Настройка 

 HiPer XT- Руководство пользователя 2-14 

- Выберите скорость передачи данных между приемником и 
компьютером (обычно 115200) из выпадающего списка Baud 
rate (скорость передачи). 

 
Рисунок 2-8. Параметры интерфейсов Bluetooth и RS232 

• Для интерфейса USB (рис. 2-9): 
- В области Connection Mode (Тип соединения) выберите 

вариант Direct (Прямое). 
- В выпадающем списке Port (Порт) выберите USB. 
- Выберите идентификатор приемника из выпадающего списка 

Rec ID (идентификаторы устройств). 

 
Рисунок 2-9. Параметры интерфейса USB
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После установления соединения PC-CDU с приемником текущие 
параметры соединения (название порта, скорость передачи данных и 
способ управление потоком данных) отображаются в левом нижнем углу 
главного окна PC-CDU. В правом нижнем углу отображается 
продолжительность текущего сеанса связи (см. рис. 2-10). 

 
Рисунок 2-10. Установлено соединение PC-CDU 

Настройка приемника  
PC-CDU позволяет настроить различные узлы приемника, сохраняя 
установки в его памяти. Настраивается, в том числе, и MINTER 
(пользовательский интерфейс, доступный на передней панели). Полное 
описание всех возможностей PC-CDU приводится в “Руководстве 
пользователя PC-CDU”. 

 
СОВЕТ 

Полное описание всех настраиваемых с помощью PC-CDU 
параметров приемника приводится в “Руководстве 
пользователя PC-CDU”. 

Описанный ниже набор установок параметров приемника является 
наиболее типичной конфигурацией, однако, Вы можете оптимизировать 
наборы установок под ваши условия выполнения работ. 

 ПРИМЕЧАНИЕ 

Новые (измененные) параметры будут переданы 
приемнику только после щелчка на кнопке Apply 
(Применить). До этого момента приемник использует 
старый набор параметров.  
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1. Подключите приемник к компьютеру. Эта процедура описана в разделе 
“Подключение приемника к персональному компьютеру” на стр. 2-10. 

2. После того, как соединение будет установлено, выберите пункт меню 
Configuration > Receiver (Настройка > Приемник), см. рис. 2-11. 

3. Выберите вкладку MINTER установите перечисленные ниже значения 
параметров настроек, после чего щелкните на кнопке Apply (см. рис. 2-
11). 

• Установите Recording interval (Интервал записи) [сек]. 
• Установите Elevation Mask for log file (минимальный угол 

возвышения для записи в файл) [градус]. 
• Задайте File name prefix (Префикс имени файла). Предлагаем 

Вам использовать последние три цифры серийного номера 
приемника. Серийный номер приемника и каталожный номер 
изделия размещены на нижней панели приемника. 

 
Рисунок 2-11. Настройка приемника - вкладка MINTER 

Если предстоит производить работы на участке, где имеются препятствия 
(здания, деревья и др.), или же антенна будет расположена вблизи 
отражающих объектов, настройте приемник так, чтобы уменьшить ошибки 
многолучевого распространения. 

 
ПРЕДУПРЕЖДЕНИЕ 

Любое изменение следует производить после 
тщательного изучения описания соответствующего 
параметра в “Руководстве пользователя PC-CDU”. 
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4. Выберите вкладку Advanced (Расширенные функции), затем вкладку 
Multipath Reduction (Подавление многолучевости), выберите 
перечисленные ниже поля и щелкните на кнопке Apply (Применить) 
(см. рис. 2-12). 
• Code multipath reduction (подавление многолучевости в измерении 

по коду). 
• Carrier multipath reduction (подавление многолучевости в 

измерении по фазе несущей). 

 
Рисунок 2-12. Настройка приемника – вкладка Advanced 

5. Выберите вкладку Loop Management (Настройка петель слежения), 
выберите указанные ниже поля и щелкните на кнопке Apply 
(Применить), см. рис. 2-13: 
• Enable Co-op tracking (Разрешить Совместное слежение). 
• Static Mode (Статический режим). 

 
Рисунок 2-13. Дополнительные функции - Настройка петель слежения 

6. Закройте диалоговое окно Receiver Configuration щелчком на кнопке 
ОК. 

7. Для завершения работы с PC-CDU выберите пункт меню File > 
Disconnect (Файл > Отключение), а затем File > Exit (Файл > Выход). 
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Предварительное закрытие сеанса связи командой Отключение 
обеспечивает корректное закрытие порта. 

 ПРИМЕЧАНИЕ 
Предварительное закрытие сеанса связи командой 
Отключение устраняет конфликты в доступе к 
последовательным портам.  

После настройки приемника его конфигурация сохраняется до тех пор, 
пока Вы не измените ее с помощью компьютера, либо очистите 
энергонезависимую память. 

Настройка пользовательского 
интерфейса MINTER 
MINTER (Minimum INTERface - минимальный интерфейс) состоит из трех 
кнопок (Питание (зеленая, слева вверху), FN (Функция) и RESET 
(Перезапуск)) и четырех светодиодов (STAT, REC, BATT и RX), с помощью 
которых можно контролировать приемник и управлять им (см. рис. 2-14). 

 
Рисунок 2-14. MINTER 

С помощью MINTER можно осуществить перечисленные ниже действия: 
• Включение и выключение приемника, перевод его в спящий (Sleep) 
режим или режим сверхнизкого энергопотребления (Zero power). 

• Включение или выключение записи данных (кнопка FN). 
• Изменение режима отображения. 
• Отображение светодиодом STAT числа отслеживаемых спутников 

GPS (зеленый цвет) и ГЛОНАСС (оранжевый).



Настройка пользовательского интерфейса MINTER 

P/N 7010-0713 2-19 

• Отображение состояния записи данных (светодиод REC). 
• Индикация цикла записи данных (светодиод REC). 
• Индикация состава записываемых данных (статический или 

динамический) при выполнении кинематической съемки для 
постобработки (производится через кнопку FN и светодиод REC). 

• Индикация состояния (полный, средний и низкий заряд) батареи 
(светодиод BATT). 

• Индикация состояния питания приемника (светодиод BATT). 
• Индикация состояния модема и приема им сигналов (светодиод RX). 

Для настройки параметров MINTER используйте PC-CDU. Полное 
описание всех возможностей PC-CDU приводится в “Руководстве 
пользователя PC-CDU”. 
1. Подключите приемник к компьютеру. Эта процедура описана в разделе 

“Подключение приемника к персональному компьютеру” стр. 2-10. 
2. В диалоговом окне Connection Parameters выберите “RTS/CTS 

handshaking” (квитирование сигналами RTS/CTS) (см. рис. 2-15). 

 
Рисунок 2-15. Connection Parameters (Параметры соединения) 

3. Выберите пункт меню Configuration > Receiver, затем выберите 
вкладку MINTER, установите перечисленные ниже значения 
параметров настроек и щелкните на кнопке Apply (см. рис. 2-16 на стр. 
2-20). Описание этих параметров приведено на следующих страницах: 

• Recording interval (Интервал записи) – стр. 2-20. 
• Mask Angle (Минимальный угол возвышения) для записи данных -
стр.2-20. 
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• File name prefix (Префикс имени файла) – стр. 2-21. 
• Always append to the file (Всегда добавлять к файлу) – стр. 2-21. 
• Files creation mode (Режим создания файлов) – на стр. 2-21. 
• Automatic File Rotation Mode (AFRM) (Режим автоматического 

создания файлов) – на стр. 2-21. 
• FN key mode (Функция кнопки FN) -  на стр. 2-23. 
• Initial data collection dynamic mode (Исходный режим съемки) - на 
стр. 2-23. 

• Data recording auto-start (Восстановление записи данных) – на 
стр. 2-23. 

 
Рисунок 2-16. Настройка приемника – вкладка MINTER 

Параметр Recording interval (Интервал записи). 
Устанавливает интервал записи блоков измерений в файл измерений. 
Файл измерений создается после нажатия кнопки FN 
(продолжительность нажатия от 1 до 5 секунд). Эта настройка 
используется как для сохранения единственного файла, так и для 
режима AFRM (Режим автоматического создания файлов). Диапазон 
допустимых значений – от 1 до 86400 сек. 
Начальное значение этого параметра - 1 секунда. 

Параметр Mask Angle (Предел угла возвышения). 
Устанавливает минимальный угол возвышения для спутников, данные 
измерений для которых записываются в файл, создаваемый после 
нажатия кнопки FN. 
Начальное значение - пять градусов. 
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Параметр File name prefix (Префикс имени файла). 
Этот параметр устанавливает начало названия файлов измерений, 
создаваемых приемником после нажатия кнопки FN. Длина префикса 
может достигать 20 символов.  
Начальная установка для префикса - “log”. 
Название файла измерений образуется следующим образом: 
<префикс><месяц><день><очередная буква алфавита> 
Название файлов зависит как от времени создания (месяц и день). 
Дополнительные буквенные суффиксы позволяют различить файлы, 
созданные в один день. 

Параметр Always append to the file (Всегда добавлять к файлу). 
Если Вы хотите, чтобы измерения добавлялись в один файл (новые 
файлы создаваться не будут), задайте название такого файла в этом 
параметре. Допустимая длина названия - до 20 символов. 

Параметр Files creation mode (Режим создания файлов). 
Этот параметр задает один из двух возможных рабочих режимов: 

• Log file (файл измерений) - если выбран этот режим, то нажатие 
на кнопку FN закрывает открытый в настоящий момент файл 
измерений. Если файл измерений не был открыт, то нажатие 
кнопки FN открывает новый файл измерений. 

• AFRM - если выбран этот режим, то нажатие на кнопку FN  
включает его. Если режим AFRM уже действует, нажатие кнопки 
FN отключает его. 

Параметр Automatic File Rotation Mode (AFRM) (Режим автоматического 
создания файлов).  

В приемниках TPS предусмотрен режим автоматического создания 
файлов. В этом режиме по определенному пользователем 
расписанию приемник закрывает текущий файл измерений и 
открывает новый. Параметры Period(Период) и Phase(Фаза) 
определяют расписание. Переключение осуществляется в тот 
момент, когда остаток от деления текущего времени приемника на 
Period равен Phase. Переключение текущего файла измерений 
производится таким образом, что момент относимости первого блока 
измерений в файле соответствует моменту времени, задаваемому в 
расписании. 
После того, как очередной файл измерений будет открыт, приемник 
сохраняет в этом файле набор типов записей с определенным 
периодом. Набор и период задаются пользователем. 
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• Period (Период) - в этом поле указывается продолжительность записи 
каждого из файлов в режиме AFRM. 
Допустимые значения периода – от 60 до 86400 секунд; начальная 
установка – 3600 сек. 

• Phase (Фаза) - устанавливает “фазу” (временной сдвиг внутри 
периода) для создания файла в режиме AFRM. 
Допустимые значения фазы – от 0 до 86400 сек; начальная установка 
– 0 сек. 

• Files(total) (Файлов, всего) - параметр, устанавливающий предельное 
количество файлов измерений, создаваемых в режиме AFRM (при 
достижении этого предела режим AFRM отключится). 
Обратите внимание на то, что первый файл измерений создается 
сразу после включения режима AFRM. Этот файл не рассматривается 
как очередной файл, и, соответственно, не увеличивает счетчик, 
предельное значение которого определяется этим параметром. 
Допустимые значения находятся в диапазоне от 0 до (231 –1); 
начальная установка – 0. Значение параметра, равное 0, 
устанавливает отмену ограничения на количество записываемых в 
режиме AFRM файлов.  

 ПРИМЕЧАНИЕ 

Максимальное количество файлов во встроенной памяти 
приемника – 512.  

• Files(remain) (Файлов, осталось) – поле отображает количество 
файлов, которое еще можно создать в режиме ARFM. 
Допустимые значения находятся в диапазоне от 0 до (231 –1); 
начальная установка – 0.  

• Automatically remove old files (автоматическое удаление устаревших 
файлов) - этот параметр анализируется, если при записи данных 
свободное пространство во встроенной памяти закончилось. Если 
флажок установлен, то в такой ситуации приемник сотрет наиболее 
ранний файл. Затирание устаревших файлов работает только в 
режиме ARFM. 
Начальная установка – не использовать.  
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Параметр FN key mode (Функция кнопки FN). 
Этот параметр определяет поведение приемника при нажатии кнопки 
FN. 

• LED blink mode switch (Переключатель режима светодиода) –
нажатие клавиши FN осуществляет выбор между режимами 
нормального или расширенного отображения и начинает или 
останавливает запись данных статической съемки. 

− кнопка FN, нажатая менее чем 1 секунду: выбор между 
режимами нормального или расширенного отображения. 

− кнопка FN, нажатая от 1 до 5 секунд: запускает или 
останавливает запись данных (режим постобработки 
статической съемки). 

• Occupation mode switch (Переключатель режима съемки) - 
нажатие кнопки FN (продолжительностью менее 1 секунды) 
инициирует добавление в файл измерений сообщения о том, что 
тип съемки был изменен со статического на кинематический или 
наоборот. Если светодиод REC вспыхивает зеленым цветом, то 
текущий режим – кинематическая съемка, если оранжевым – 
статическая съемка. Более подробная информация представлена 
в таблице 4-1 на стр. 4-5, а также в Руководстве пользователя  
MINTER и в Руководстве пользователя PC-CDU. 

Параметр Initial data collection dynamic mode (Исходный режим съемки). 
В этом поле осуществляется выбор сообщения с признаком типа 
съемки, которое записывается в начало файла измерений. При 
выборе кнопки Static (Статическая) происходит запись сообщения 
STOP, при выборе кнопки Kinematic (Кинематическая) – сообщения 
GO,Trajectory. 

 Параметр Data recording auto-start (Восстановление записи данных). 
В этом поле осуществляется выбор того, каким способом 
продолжается запись файла измерений при восстановлении 
напряжения питания после сбоя. 
В таблице 2-2 на стр. 2-24 приведены различные возможные 
сценарии и результаты после восстановления питания приемника. 
Под термином “Заданный” файл следует понимать название файла, 
определенное в параметре Always append to the file (Всегда 
добавлять в файл). "Автоматический" файл – файл, название 
которого создано в режиме AFRM. 
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Таблица 2-2 Алгоритм, устанавливаемый параметром Data recording autostart 

Результат при выбранном значении параметра 
Перед сбоем 
питания Off (Выкл.) On (Вкл.) Always (Всегда) 

1 
Измерения 
сохранялись в 
"заданном" 
файле. 

После 
восстановления 
питания запись 
данных не 
возобновится. 

После 
восстановления 
питания приемник 
возобновит запись 
данных в тот же 
файл. 

После 
восстановления 
питания приемник 
возобновит запись 
данных в тот же 
файл. 

2 
Данные в 
приемнике 
сохранялись в 
"автоматическо
м" файле 

После 
восстановления 
питания запись 
данных не 
возобновится. 

После 
восстановления 
питания откроется 
новый файл, и 
данные будут 
записываться в 
него. 

После 
восстановления 
питания откроется 
новый файл, и 
данные будут 
записываться в 
него. 

3 
Название 
файла задано, 
но приемник 
еще не начал 
запись данных 

После 
восстановления 
питания запись 
данных не 
начнется. 

“Заданный" файл не 
откроется. После 
восстановления 
питания запись 
данных не начнется 

Откроется 
“заданный” файл и 
после 
восстановления 
питания начнется 
запись данных  

4 
Файл не 
установлен; 
запись данных 
приемником 
выключена 

После 
восстановления 
питания запись 
данных не 
начнется 

После 
восстановления 
питания запись 
данных не начнется 

Откроется 
"автоматический" 
файл и после 
восстановления 
питания начнется 
запись данных 

Помимо этого, если выбрано поле Always, приемник автоматически начнет 
запись данных (во вновь созданный или уже существующий файл) в 
следующих трех случаях: 

• После включения приемника с помощью кнопки POWER (питание) 

• После перезапуска приемника (с помощью PC-CDU или нажатием 
кнопки RESET (Перезапуск)). 

• После выведения приемника из режима ожидания. 
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Настройка радиомодема 
Программа Modem-TPS предназначена для настройки радиомодема, 
встроенного в приемники семейства HiPer. Modem-TPS обеспечивает 
выполнение следующих функций: 

• Соединение персонального компьютера со встроенным радиомодемом 
через последовательный порт или при помощи Bluetooth. 

• Отображение информации о радиомодеме, установленном в 
приемнике. 

• Программирование установок радиомодема. 
Порядок настройки HiPer XT с УКВ радиомодемом и терминалом GSM с 
помощью Modem-TPS изложены ниже. 
Программное обеспечение TopSURV фирмы Topcon также может 
использоваться для настройки приемников HiPer. Подробности см. в 
Справочном руководстве TopSURV и Руководстве пользователя 
TopSURV. 

 ПРИМЕЧАНИЕ 

Имейте в виду, что одновременная работа УКВ 
радиомодема и модема GSM не допускается. В каждый 
момент времени можно использовать только один 
радиоканал. 

 ПРИМЕЧАНИЕ 

Обязательно разорвите соединение до завершения 
работы программы Modem-TPS для предупреждения 
возможных конфликтов в доступе к  последовательному 
порту после завершения настройки радиомодема. 

Установка программы Modem-TPS 
Программа Modem-TPS устанавливается с компакт-диска GPS+. Для 
начала процесса установки вставьте компакт диск в дисковод CD-ROM. 
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Требования к компьютеру для программы Modem-TPS: Windows® 98 и 
выше, наличие порта RS-232С или USB. Используйте программу Modem-
TPS версии 1.7 и выше. 
1. Найдите поддиректорию с программу Modem-TPS и дважды щелкните 

на иконке Setup.exe. 
2. Программу можно установить в директорию, предлагаемую по 

умолчанию, либо выбрать другую. Щелкните на кнопке Finish 
(Завершить). 

 
Рисунок 2-17. Выберите место установки Modem-TPS и установите программу 

3. Для завершения установки щелкните на кнопке OK. 
4. Если это желательно, для быстрого доступа к Modem-TPS на рабочем 

столе можно создать соответствующий ярлык, см. рис. 2-18. 

 

 
 

Рисунок 2-18. Завершение установки и создание ярлыка 

Для удаления Modem-TPS воспользуйтесь меню Пуск операционной 
системы: 

Выберите пункт меню Пуск > Программы > Modem-TPS > Uninstall 
Modem-TPS и щелкните на кнопке Yes для подтверждения. Когда 
удаление будет закончено, щелкните на кнопке ОК. 
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Настройка УКВ радиомодема 
базовой станции 
 

 ПРИМЕЧАНИЕ 

Санитарно-гигиенические нормы эксплуатации 
радиосредств выполняются на удалении более 25 см от 
антенны радиомодема. 

УКВ радиомодем, встроенный в приемник HiPer XT, обеспечивает обмен 
данными по УКВ каналу между базовой станцией и подвижным 
приемником. Для настройки УКВ радиомодемов необходимы: 

• Компьютер с операционной системой Windows-98 и выше. 

• Программное обеспечение Modem-TPS версии 1.7 или выше. 

• Кабель последовательного порта (или возможность связи по 
Bluetooth). 

1. C помощью кабеля RS232 или через Bluetooth соедините приемник с 
компьютером. 

2. Включите приемник. 
3. Запустите программу Modem-TPS и выберите последовательный 

(СОМ) порт подключения приемника (см. рис. 2-19). 
4. Щелкните на кнопке Connect. 

 
Рисунок 2-19. Подключение Modem-TPS 
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5. На вкладке Radio Link (радиоканал) установите следующие параметры  
радиомодема базовой станции (см. рис. 2-20 на стр. 2-29): 
• Protocol (Протокол) – выберите протокол FCS фирмы Topcon. Это 
является начальной установкой. 

• Modulation Type (Тип модуляции) – начальной установкой 
является GMSK (Gaussian Minimum Shift Keying - гауссовская 
манипуляция с минимальным частотным сдвигом), что и 
рекомендуется для большинства приложений. В таблице 2-3 
перечислены рекомендованные типы модуляции для разных 
скоростей передачи данных по эфиру. Альтернативный вариант – 
4-уровневая FSK (комбинированная амплитудно-частотная 
манипуляция). 

• Link Rate (скорость передачи данных по эфиру) – начальной 
установкой является 9600 бод, что и рекомендуется для 
большинства приложений. В таблице 2-3 перечислены 
рекомендованные типы модуляции для разных скоростей 
передачи данных по эфиру.  

Таблица 2-3. Скорость передачи данных в зависимости от типа модуляции 
Для этой скорости передачи 

данных 
Используйте этот тип 

модуляции 
4 800 бод GMSK 
9 600 бод (начальная установка, 
рекомендованное значение) 

GMSK или 4-уровневая FSK 

19 200 бод 4 уровневая FSK 

• TX – установите номинал частоты, который будет использоваться 
радиомодемом базовой станции для передачи 
дифференциальных поправок. 

• Scrambling (скремблирование, перемежение данных) – за счет 
устранения длинных последовательностей одинаковых символов 
при передаче повышает надежность приема, полезно при 
неблагоприятном отношении сигнал/шум. 

• Forward Error Correction, FEC (кодирование с упреждающим 
исправлением ошибок) – при передачи данные сопровождаются 
контрольной информацией, позволяющей восстановить при 
приеме утерянные из-за помех символы. При использовании FEC 
надежность передачи данных повышается 
ПРИМЕЧАНИЕ: FEC уменьшает пропускную способность канала 
связи из-за добавления дополнительных контрольных битов в 
поток данных. При использовании FEC для передачи 
дифференциальных поправок рекомендуется выбрать скорость 
передачи данных 19200 бод и 4-х уровневую FSK модуляцию. 

• Protocol Mode (протокол) – начальной установкой является 
Transparent w/EOT Timeout и рекомендуется для большинства 



Настройка радиомодема 

P/N 7010-0713 2-29 

приложений. Установка должна быть одинаковой на базовом и 
подвижном приемниках. 

• TX ACK Timeout (in x 10ms) (тайм-аут подтверждения передачи, 
единица измерения 10 мс) – для режима работы в протоколе 
Transparent w/EOT Timeout введите целочисленную величину в 
диапазоне от 1 (10 мс) до 50 (500 мс). Как только перерыв в 
потоке входных данных превысит установленный временной 
интервал, модем передаст пакет подтверждения приема.  

• Output Power (Мощность передатчика) – выбор уровня мощности  
передатчика, диапазон (от 10 мВт до 2 Вт).  

 
Рисунок 2-20. Пример выбора параметров линии передачи данных для базовой 

станции 

6. Продолжите далее настройку радиомодема базовой станции, выбрав 
выделенный канал, или канал FCS. 

• При использовании выделенного канала единственный номинал 
частоты используется одновременно для базовой и подвижной 
станции. 

• При использовании режима FCS несколько номиналов частот 
задаются для использования базовой и подвижными станциями. В 
этом случае производится автоматический перебор частотных 
каналов с выбором лучшего из них. 
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Вариант А: Использование выделенного 
канала 
1. Выполнив шаги с первого по пятый раздела “Настройка УКВ 

радиомодема базовой станции”, см. стр. 2-27, выберите вкладку Serial 
Interface (Последовательный интерфейс).  

2. Во вкладке Serial Interface  (Последовательный интерфейс) выберите 
скорость передачи данных для последовательного порта радиомодема 
(см. рис. 2-21). Для последовательных портов приемника и 
радиомодема следует установить одинаковую скорость. 

 
Рисунок 2-21 Пример выбора скорости передачи данных для модема 

3. Щелкните на кнопке Apply (Применить), затем выберите пункт меню 
File > Disconnect (Файл > Отключить). Для закрытия программы 
Modem-TPS выберите пункт меню File > Exit (Файл > Выход).  

4. С помощью PC-CDU настройте HiPer XT в качестве базовой станции 
RTK. 

Вариант В: Использование сканирования 
свободного канала 
1. Выполнив шаги с первого по пятый раздела “Настройка УКВ 

радиомодема базовой станции”, см. стр. 2-27, выберите вкладку FSC.  
2. На вкладке FCS установите перечисленные ниже параметры 

радиомодема базовой станции (см. рис. 2-22 на стр. 2-31): 
• Mode (Режим) – для базовой станции выберите Master (Ведущий). 
• Free Scan Frequency List (Перечень частот сканирования) – 
задайте, по крайней мере, два номинала частот для 
сканирования. Двойным щелчком можно включить и исключить 
номинал частоты из процесса сканирования. 
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• Time Out (Таймаут) - введите период отсылки  «служебного 
слова» радиомодемом базовой станции (единица измерения - 
секунды). Таймаут должен быть больше (на 2-3 секунды), чем 
период передачи дифференциальных поправок. 

• Noise Level (Уровень шума) – выберите порог для уровня шума. 
- High (Высокий): устанавливает уровень шума –70 дБм. 
Рекомендуется в условиях сильных помех. 

- Medium (Средний): устанавливает уровень шума –85 дБм. 
Рекомендуется в большинстве случаев. 

- Low (Низкий): устанавливает уровень шума –100 дБм. 
Рекомендуется в условиях слабых помех. 

Радиомодем базовой станции регулярно сканирует эфир на текущей 
частоте для определения степени радиопомех. Если уровень шума на 
рабочей частоте превысит установленное в этом поле значение, 
передатчик прекратит передачу на этой частоте. Затем он переключится 
на другую частоту из перечня (см. выше) и будет продолжать 
сканирование на новой частоте. Если на новой частоте уровень шумов 
низкий, радиомодем продолжит передачу данных на ней. В противном 
случае радиомодем продолжит процесс сканирования по частотам в 
перечне до тех пор, пока не будет найдена частота с приемлемым 
уровнем шумов. 

 
Рисунок 2-22. Выбор параметров FCS для базовой станции 
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3. На вкладке Serial Interface  (Последовательный интерфейс) выберите 
скорость передачи данных для последовательного порта радиомодема 
(см. рис. 2-21 на стр. 2-30). Для последовательных портов приемника и 
радиомодема следует установить одинаковую скорость. 

4. Щелкните на кнопке Apply (Применить), затем выберите пункт меню 
File > Disconnect (Файл > Отключить). Для закрытия программы 
Modem-TPS выберите пункт меню File > Exit (Файл > Выход). 

5. С помощью PC-CDU настройте HiPer XT в качестве базовой станции 
RTK. 

Настройка УКВ радиомодема 
подвижной станции 
 

 ПРИМЕЧАНИЕ 

Санитарно-гигиенические нормы эксплуатации 
радиосредств выполняются на удалении более 25 см от 
антенны радиомодема. 

УКВ радиомодем, встроенный в приемники HiPer XT, обеспечивает обмен 
данными по УКВ каналу между базовой станцией и подвижным 
приемником. Для настройки УКВ радиомодемов необходимы: 

• Компьютер с операционной системой Windows-98 и выше. 

• Программное обеспечение Modem-TPS версии 1.7 или выше. 

• Кабель последовательного порта (или возможность связи по 
Bluetooth). 

Обратите внимание на то, что многие операции по настройке 
радиомодема подвижной и базовой станции совпадают. 
1. C помощью кабеля RS232 или через Bluetooth соедините приемник с 

компьютером. 
2. Включите приемник. 
3. Запустите программу Modem-TPS и выберите последовательный 

(СОМ) порт подключения приемника (см. рис. 2-23 на стр. 2-33). 
4. Щелкните на кнопке Connect. 
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Рисунок 2-23. Подключение Modem-TPS 

5. На вкладке Radio Link (радиоканал) установите следующие параметры  
радиомодема базовой станции (см рис. 2-24 на стр. 2-34):  

• Protocol (Протокол) – выберите протокол FCS фирмы Topcon. Это 
является начальной установкой. 

• Modulation Type (Тип модуляции) – начальной установкой 
является GMSK (Gaussian Minimum Shift Keying - гауссовская 
манипуляция с минимальным частотным сдвигом), что и 
рекомендуется для большинства приложений. В таблице 2-4 
перечислены рекомендованные типы модуляции для разных 
скоростей передачи данных по эфиру. Альтернативный вариант – 
4-уровневая FSK (комбинированная амплитудно-частотная 
манипуляция). 

• Link Rate (скорость передачи данных по эфиру) – начальной 
установкой является 9600 бод, что и рекомендуется для 
большинства приложений. В таблице 2-3 перечислены 
рекомендованные типы модуляции для разных скоростей 
передачи данных по эфиру.   

Таблица 2-4 Скорость передачи данных в зависимости от типа модуляции 

Для данной скорости передачи 
данных 

Используйте этот тип 
модуляции 

4 800  бод GMSK 
9 600 бод (начальная установка, 
рекомендованное значение) 

GMSK или 4 уровневая 
FSK 

19 200 бод 4 уровневая FSK 

• RX – установите номинал частоты, который будет использоваться 
радиомодемом подвижной станции для приема 
дифференциальных поправок. 

• Scrambling (скремблирование, перемежение данных) – за счет 
устранения длинных последовательностей одинаковых символов 
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при передаче повышает надежность приема, полезно при 
неблагоприятном отношении сигнал/шум. 

• Forward Error Correction, FEC (кодирование с упреждающим 
исправлением ошибок) – при передачи данные сопровождаются 
контрольной информацией, позволяющей восстановить при 
приеме утерянные из-за помех символы. При использовании FEC 
надежность передачи данных повышается 
ПРИМЕЧАНИЕ: FEC уменьшает пропускную способность канала 
связи из-за добавления дополнительных контрольных битов в 
поток данных. При использовании FEC для передачи 
дифференциальных поправок рекомендуется выбрать скорость 
передачи данных 19200 бод и 4-х уровневую FSK модуляцию. 

• Protocol Mode (протокол) – начальной установкой является 
Transparent w/EOT Timeout и рекомендуется для большинства 
приложений. 

• TX ACK Timeout (in x 10ms) (тайм-аут подтверждения передачи, 
единица измерения 10 мс) – для режима работы в протоколе 
Transparent w/EOT Timeout введите целочисленную величину в 
диапазоне от 1 (10 мс) до 50 (500 мс). Как только перерыв в 
потоке входных данных превысит установленную величину, 
модем начинает передачу данных.   

• Output Power (Мощность передатчика) – выбор уровня мощности  
передатчика, диапазон (от 10 мВт до 2 Вт). 

 
Рисунок 2-24 Пример выбора параметров линии передачи данных для подвижной 

станции 
6. Продолжите далее настройку радиомодема подвижной станции, 

выбрав выделенный канал, или канал FCS. 

• При использовании выделенного канала единственный номинал 
частоты используется одновременно для базовой и подвижной 
станции. 
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• При использовании режима FCS несколько номиналов частот 
задаются для использования базовой и подвижными станциями. В 
этом случае производится автоматический перебор частотных 
каналов с выбором лучшего из них. 

Вариант А: Использование выделенного 
канала  
1. Выполнив шаги с первого по пятый раздела “Настройка УКВ 

радиомодема подвижной станции”, см. стр. 2-32, выберите вкладку 
Serial Interface (Последовательный интерфейс). 

2. Во вкладке Serial Interface  (Последовательный интерфейс) выберите 
скорость передачи данных для последовательного порта радиомодема 
(см. рис. 2-21). Для последовательных портов приемника и 
радиомодема следует установить одинаковую скорость. 

 
Рисунок 2-25. Пример выбора скорости передачи данных для модема 

3. Щелкните на кнопке Apply (Применить), затем выберите пункт меню 
File > Disconnect (Файл > Отключить). Для закрытия программы 
Modem-TPS выберите пункт меню File > Exit (Файл > Выход).   

4. С помощью PC-CDU настройте HiPer XT в качестве подвижной станции 
RTK. 

Вариант В: Использование сканирования 
свободного канала  
1. Выполнив шаги с первого по пятый раздела “Настройка УКВ 

радиомодема подвижной станции”, см. стр. 2-32, выберите вкладку 
FSC. 

2. На вкладке FCS установите перечисленные ниже параметры 
радиомодема подвижной станции (см. рис. 2-26 на стр.2-36): 
• Mode (Режим) – для подвижной станции выберите Slave 

(Подчиненный). 
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• Free Scan Frequency List (Перечень частот сканирования) – 
задайте те же частоты, что и для базовой станции.  

• Time Out (Таймаут) - введите период отсылки  «служебного 
слова» радиомодемом базовой станции (единица измерения - 
секунды). Таймаут должен быть больше (на 2-3 секунды), чем 
период передачи дифференциальных поправок. 

• Noise Level (Уровень шума) – выберите порог для уровня шума. 
- High (Высокий): устанавливает уровень шума –70 дБм. 
Рекомендуется в условиях сильных помех. 

- Medium (Средний): устанавливает уровень шума –85 дБм. 
Рекомендуется в большинстве случаев. 

- Low (Низкий): устанавливает уровень шума –100 дБм. 
Рекомендуется в условиях слабых помех 

Радиомодем базовой станции регулярно сканирует эфир на 
текущей частоте для определения степени радиопомех. Если 
уровень шума на рабочей частоте превысит установленное в 
этом поле значение, передатчик прекратит передачу на этой 
частоте. Затем он переключится на другую частоту из перечня 
(см. выше) и будет продолжать сканирование на новой частоте. 
Если на новой частоте уровень шумов низкий, радиомодем 
продолжит передачу данных на ней. В противном случае 
радиомодем продолжит процесс сканирования по частотам в 
перечне до тех пор, пока не будет найдена частота с 
приемлемым уровнем шумов. 

 
Рисунок 2-26 Пример выбора параметров FCS для подвижной станции 
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3. Во вкладке Serial Interface  (Последовательный интерфейс) выберите 
скорость передачи данных для последовательного порта радиомодема 
(см. рис. 2-21 на стр. 2-30). Для последовательных портов приемника и 
радиомодема следует установить одинаковую скорость. 

4. Щелкните на кнопке Apply (Применить), затем выберите пункт меню 
File > Disconnect (Файл > Отключить). Для закрытия программы 
Modem-TPS выберите пункт меню File > Exit (Файл > Выход). 

5. С помощью PC-CDU настройте HiPer XT в качестве подвижной станции 
RTK. 

Использование Modem-TPS для 
настройки GSM модуля базовой 
станции 
Для предупреждения возможных конфликтов в доступе к  
последовательному порту после завершения настройки GSM модуля, 
обязательно разорвите соединение до завершения работы программы 
Modem-TPS. 

 ПРИМЕЧАНИЕ 

Санитарно-гигиенические нормы эксплуатации 
радиосредств выполняются на удалении более 25 см от 
антенны GSM модуля. 

GSM модуль, встроенный в приемник HiPer XT, обеспечивает обмен 
данными по сети сотовой телефонии GSM между базовой станцией и 
подвижным приемником. Для настройки GSM модулей необходимы: 

• Компьютер с операционной системой Windows 98 и выше. 
• Программное обеспечение Modem-TPS версии 1.7 или выше. 
• Кабель последовательного порта (или возможность связи по 

Bluetooth). 
• Номер GSM телефона базовой станции.  

1. C помощью кабеля RS232 или через Bluetooth соедините приемник с 
компьютером. 

2. Включите приемник. 
3. Запустите программу Modem-TPS и выберите последовательный 

(СОМ) порт подключения приемника (см. рис. 2-27 на стр. 2-38). 
4. Щелкните на кнопке Connect. 
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Рисунок 2-27. Подключение Modem-TPS 

5. На вкладке GSM (см. рис. 2-28 на стр. 2-38) введите следующие 
параметры: 

• Mode (Режим) – для базовой станции выберите Slave 
(Подчиненный). 

• PIN (персональный код) – при необходимости задайте 
персональный идентификационный код. 

• Dial (Вызываемый номер) – для базовой станции оставьте пустым. 

• Send time (время передачи) – введите период времени в секундах, 
с которым GSM модем базовой станции будет посылать 
служебное слово на радиомодем подвижной станции. Этот 
параметр используется для поддержания надежной связи между 
двумя модемами и позволяет избежать повторной инициализации 
модема.  
Для обеспечения надежной связи между модемами этот 
параметр должен быть больше, чем период передачи 
дифференциальных поправок. 
Если и базовая и подвижная станции - приемники HiPer XT с 
внутренними GSM модемами, установите значение 0 для 
параметра Send Time. 
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Рисунок 2-28. Пример выборы параметров GSM для базовой станции 

6. Во вкладке Serial Interface  (Последовательный интерфейс) выберите 
скорость передачи данных для последовательного порта модема (см. 
рис. 2-21 на стр. 2-30). Для последовательных портов приемника и 
модема следует установить одинаковую скорость. 

7. Щелкните на кнопке Apply (Применить), затем выберите пункт меню 
File > Disconnect (Файл > Отключить). Для закрытия программы 
Modem-TPS выберите пункт меню File > Exit (Файл > Выход). 

8. С помощью PC-CDU настройте HiPer XT в качестве базовой станции 
RTK. 

Использование Modem-TPS для 
настройки GSM модуля подвижной 
станции 
Для предупреждения возможных конфликтов в доступе к  
последовательному порту после завершения настройки GSM модуля, 
обязательно разорвите соединение до завершения работы программы 
Modem-TPS. 

 ПРИМЕЧАНИЕ 
Санитарно-гигиенические нормы эксплуатации 
радиосредств выполняются на удалении более 25 см от 
антенны GSM модуля. 

1. Выполнив шаги с первого по пятый раздела “Использование Modem-
TPS для настройки GSM модуля базовой станции”, см. стр. 2-37. 

2. На вкладке GSM (см. рис. 2-29 на стр. 2-40) введите следующие 
параметры: 
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• Mode (Режим) – для подвижной станции выберите Master 
(Ведущий). 

• PIN (персональный код) – при необходимости задайте 
персональный идентификационный код. 

• Dial (Вызываемый номер) – введите номер базовой станции. 
• Send time (время передачи) – введите период времени в секундах, 
с которым GSM модем подвижной станции будет посылать 
служебное слово на модем базовой станции. Этот параметр 
используется для поддержания надежной связи между двумя 
модемами и позволяет избежать повторную инициализацию 
модема.  
Если и базовая и подвижная станции - приемники HiPer XT с 
внутренними GSM модемами, установите значение 0 для 
параметра Send Time. 

 
Рисунок 2-29. Пример выбора параметров GSM для подвижной станции 

3. Во вкладке Serial Interface  (Последовательный интерфейс) выберите 
скорость передачи данных для последовательного порта модема (см. 
рис. 2-21 на стр. 2-30). Для последовательных портов приемника и 
модема следует установить одинаковую скорость. 

4. Щелкните на кнопке Apply (Применить), затем выберите пункт меню 
File > Disconnect (Файл > Отключить). Для закрытия программы 
Modem-TPS выберите пункт меню File > Exit (Файл > Выход). 

5. С помощью PC-CDU настройте HiPer XT в качестве подвижной станции 
RTK.
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Настройка модуля Bluetooth 
Программа BTCONF производства фирмы Topcon предназначена для 
настройки модуля Bluetooth и позволяет: 

• получить доступ к модулю Bluetooth. 

• настроить модуль Bluetooth. 

• проверить или изменить настройки модуля. 
Для доступа к модулю Bluetooth, прежде всего, установите программу 
BTCONF на компьютер, затем установите соединение между компьютером  
и приемником и запустите программу настройки. 
1. Создайте папку: C:\Program Files\TPS\BTCONF. 
2. Скопируйте файл архива btconf.zip с прилагающегося к приемнику 

диска и распакуйте его в указанную выше папку. Этот файл содержит 
выполнимый модуль BTCONF.EXE – программу настройки модуля 
Bluetooth. 

Каждый раз, когда Вы запускаете BTCONF и настраиваете модуль 
Bluetooth, BTCONF сохраняет последние сделанные Вами установки в 
служебном файле btconf.ini. BTCONF автоматически обновляет этот файл 
всякий раз, когда Вы изменяете настройки модуля Bluetooth. 

 
СОВЕТ 

Для сохранения различных наборов установок модуля 
Bluetooth для  различных применений сохраняйте копии 
BTCONF в различных папках. 

Для удаления BTCONF, удалите все директории и ярлыки BTCONF. 
После того, как BTCONF установлен, для настройки модуля Bluetooth 
выполните следующие операции.  
1. С помощью кабеля RS232 соедините последовательный порт 
компьютера (обычно COM1) с последовательным портом А приемника. 
Включите приемник и компьютер.   
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2. Запустите программу настройки модуля Bluetooth BTCONF.EXE (см. 
рис. 2-30). 

 
Рисунок 2-30. Главный экран программы настройки модуля Bluetooth 

Обратите внимание, что в нижнем левом углу состояние модуля 
отображается как Disconnected (Не подключен). 
Данные о версии программы и авторских правах отображаются в окне, 
появляющемся после щелчка на кнопке About (О программе). 

3. Выберите последовательный порт компьютера для связи с модулем 
(обычно COM1) из выпадающего списка в левом верхнем углу. 

4. Для соединения компьютера и модуля Bluetooth щелкните на кнопке 
Connect (Соединить) (см. рис.2-31). 

 
Рисунок 2-31. Выберите порт для связи и щелкните на кнопке Connect (Соединить) 
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После того, как будет установлено соединение приемника и компьютера,  
на вкладке Identification (Идентификация), см. рис.2-32, появится 
следующая информация: 

• Bluetooth name – название модуля Bluetooth. 

• Bluetooth address – уникальный электронный адрес модуля. 

• Firmware version – текущая версия встроенного программного 
обеспечения модуля Bluetooth. 

 
Рисунок 2-32. BTCONF. Вкладка Идентификация  

Номер последовательного (COM) порта и скорость передачи данных 
отображаются в левом нижнем углу. 

5. Выберите вкладку Parameters (Параметры) (см. рис. 2-33 на стр. 2-44). 
На ней можно установить идентификатор (название) модуля. В области 
Security (Безопасность) устанавливаются параметры защиты от 
несанкционированного доступа.  
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6. Введите уникальное название модуля Bluetooth длиной до 14 символов 
(см. рис. 2-33) и щелкните на кнопке Apply (Применить).  

 

Рисунок 2-33. BTCONF. Вкладка Параметры 

7. Установите перечисленные ниже параметры безопасности (см. рис. 2-
34 на стр. 2-45) и щелкните на кнопке Apply:  

• Bluetooth PIN (персональный идентификационный код Bluetooth) 
– введите для установления персонального идентификационного 
кода модуля Bluetooth (до 16 символов). 

• Encryption (шифрование) – если это поле выбрано, то по 
беспроводному каналу Bluetooth данные будут передаваться в 
зашифрованном виде. 

• Authentication (аутентификация, проверка подлинности) – если 
это поле выбрано, то соединение будет установлено только после 
предоставления вторым устройством PIN кода, введенного в поле 
Bluetooth PIN.  

 ПРИМЕЧАНИЕ 

Если Вы не хотите использовать защиту канала данных, 
оставьте перечисленные выше поля незаполненными. 
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Рисунок 2-34. BTCONF. Вкладка Параметры. Область Безопасность 

8. Выберите вкладку Serial Interface (Последовательный интерфейс) (см. 
рис. 2-35). Выберите поле Echo (Эхо) если хотите, чтобы модуль 
Bluetooth посылал принятые символы обратно (полезно при доступе 
через терминальную программу). При необходимости щелкните на 
кнопке Apply (Применить).  

 
Рисунок 2-35. BTCONF. Вкладка Последовательный интерфейс 



Настройка 

 HiPer XT- Руководство пользователя 2-46 

9. Для выхода из программы BTCONF щелкните на кнопке Disconnect 
(Отсоединить), затем Exit (Выход), см. рис. 2-36. 

 
Рисунок 2-36. Выход из BTCONF. Disconnect, затем Exit 

Сбор альманахов 
Каждый спутник в составе навигационного сообщения, в частности, 
передает альманах навигационной системы. В альманахе содержатся 
грубые параметры орбит для всех спутников навигационной системы. 
Если в приемнике сохранен действующий альманах, то время, 
необходимое для поиска и захвата спутниковых сигналов, существенно 
уменьшается. 
Приемник регулярно обновляет альманах и сохраняет самый поздний 
альманах в своей энергонезависимой памяти (NVRAM). 
1. Установите приемник (соедините с внешней антенной, если это 

необходимо) в месте, где небосвод виден без затенений. 
2. Включите приемник. 
3. Подождите примерно 15 минут, пока приемник собирает данные 

альманаха от спутников. 

 ПРИМЕЧАНИЕ 

Если 15 минут прошло, а приемник не захватил 
спутниковые сигналы, возможно, Вам придется очистить 
энергонезависимую память (NVRAM). Эта процедура 
описана в разделе “Очистка энергонезависимой памяти 
NVRAM“ на стр. 4-17.
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Следует собрать или обновить альманах при следующих условиях: 

• Если приемник был выключен в течение продолжительного 
периода времени. 

• Если последнее известное для приемника местоположение, 
сохраненное в энергонезависимой памяти (NVRAM) отличается от 
текущего местоположения на несколько сотен километров. 

• После загрузки нового OAF. 

• После загрузки нового встроенного программного обеспечения. 

• После очистки энергонезависимой памяти (NVRAM). 

• Перед съемкой.
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Для заметок: 
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Глава 3  
Установка и съемка 
В этой главе описываются: 

• Установка приемника. 

• Установка базовой станции RTK (кинематической съемки в реальном 
времени). 

• Установка подвижной станции RTK. 

• Основы проведения съемки с помощью приемника HiPer XT. 
В комплект поставки входят два приемника HiPer XT - один для 
использования в качестве базовой станции, а второй – для  подвижной 
станции. 

Установка приемника 
 

 ПРИМЕЧАНИЕ 

Имейте в виду, что УКВ и GSM приемопередатчики не 
работают одновременно. В каждый момент времени 
можно использовать только один из этих радиоканалов. 

Для установки приемников Вы должны:  
1. Настроить приемники (см. Главу 2). 
2. Установить базовую и подвижную станции. См. раздел "Шаг 1: 

Установка приемника” на стр. 3-2. 
3. Измерьте высоту антенны. См. раздел “Шаг 2: Измерение высоты 

антенны” на стр. 3-2. 
4. Начните сбор данных. См. раздел “Шаг 3. Сбор данных” на стр.3-4. 
Все приемники оснащены внутренней микрополосковой антенной, 
способной принимать сигналы частотных поддиапазонов L1 и L2 спутников 
GPS и ГЛОНАСС.
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Шаг 1: Установка приемника 
В данном разделе подразумевается, что приемник настроен заранее. 
1. Закрепите приемник на соответствующем штативе или вешке. 
2. Отцентрируйте приемник над центром пункта, координаты которого 

подлежат определению. Спутниковый приемник следует устанавливать 
в месте с хорошим обзором небосвода. 

Шаг 2: Измерение высоты антенны 
Определение превышения антенны над центром пункта чрезвычайно 
важно при использовании спутниковых методов съемки. Даже если 
определению подлежат только плановые координаты, обработка данных 
спутниковой съемки всегда производится с определением полного 
(трехмерного) местоположения фазового центра приемной антенны.  
Поскольку приемник вычисляет координаты фазового центра антенны, для 
их редукции на центр пункта следует указать следующее: 

• Измеренную высоту антенны над центром пункта. 

• Метод измерения высоты антенны. 

• Модель используемой антенны. 
Измерять высоту антенны можно двумя способами: 

• Вертикальный – измеряется длина отрезка от центра до базовой 
точки антенны (antenna reference point, ARP) расположенной на 
нижней части приемника на нижнем основании втулки станового 
винта. 

• Наклонный - измеряется длина отрезка от центра до одной из точек 
относимости наклонной высоты (slant height measure mark, SHMM), 
обозначены на лицевой и задней панелях приемника.  

1. Измерение высоты антенны над точкой или маркером. 
На рис. 3-1 показано взаимное положение ARP и SHMM. 
(Расположение отметок SHMM на панелях приемника показано на рис. 
1-5 стр. 1-15 и на рис. 1-6 стр. 1-16). 
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Рисунок 3-1. Смещения антенны HiPer XT 

• Смещение SHMM относительно APR по вертикали = 30,50 мм. 

• Смещение SHMM относительно APR по горизонтали = 77,75 мм. 
В таблице 3-1 приведены значения смещений для приемников. 

Таблица 3-1. Значения смещений фазового центра относительно ARP для разных 
частотных поддиапазонов 

 
 К фазовому центру L1 К фазовому центру L2 

Вверх 105,9 мм 97,1 мм 

Точка, координаты которой определяются в процессе съемки с 
помощью GPS/ГЛОНАСС, называется фазовым центром антенны. 
Можно провести аналогию с триппель-призмой, при измерении 
расстояний до которой измерение производится до точки, 
расположенной внутри призмы, и пользователь должен учесть в 
обработке измерений постоянную призмы для пересчета измеренного 
расстояния на конструктив призмы. В случае GPS/ГЛОНАСС антенны 
порядок учета смещения фазового центра зависит от использованного 
способа измерения высоты антенны. Для вертикального измерения 
(измерение до ARP) смещение просто добавляется к измеренной 
высоте и получается «истинное» превышение. Для наклонной высоты 
(измерение до SHMM), прежде всего производится приведение этого 
измерения на вертикальное измерение (взаимное положение ARP и 
SHMM см. выше).  

2. В полевой журнал запишите название пункта, высоту антенны над 
центром и способ ее измерения, укажите и время начала работы.  
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3. Для включения приемника нажмите и отпустите кнопку POWER. 
Светодиод STAT будет вспыхивать красным цветом в начале работы. 

4. Как только приемник установит слежение от одного или нескольких 
спутников, светодиод STAT будет вспыхивать зеленым цветом для 
спутников GPS и оранжевым для спутников ГЛОНАСС. Короткие 
красные вспышки означают, что местоположение еще не определено. 
Местоопределение обеспечивается при слежении за четырьмя и более 
спутниками. 

5. Окончание коротких красных вспышек свидетельствует о том, что, 
приемник определил местоположение и можно начинать съемку. Перед 
началом сбора данных следует дождаться зеленых и оранжевых 
вспышек. Это гарантирует, что приемник определил правильные дату и 
время, а также отслеживает достаточно большое количество 
спутников, обеспечивающих хорошее качество данных.  
Процесс захвата спутниковых сигналов обычно занимает менее одной 
минуты. На новом месте, под густой кроной деревьев или после 
перезапуска приемника это может занять несколько минут. 

Шаг 3. Сбор данных 
1. Для начала сбора данных нажмите и удерживайте кнопку FN (function- 

функция) более одной секунды, но менее пяти секунд. 
2. Отпустите кнопку FN, когда светодиод REC (recording – запись) станет 

светиться зеленым цветом. Это указывает на то, что открылся файл, и 
началась запись данных. Светодиод мигает каждый раз, когда 
происходит сохранение данных  во внутреннюю память. 

 
СОВЕТ 

Для настройки процесса сохранения данных используйте 
программу PC-CDU, см. раздел “Настройка 
пользовательского интерфейса MINTER“ на стр. 2-18 или 
обратитесь к “Руководству пользователя PC-CDU”. 

3. Для окончания сеанса наблюдений нажмите и удерживайте кнопку FN 
до тех пор, пока светодиод REC не погаснет. 

4. Для выключения приемника нажмите и удерживайте в нажатом 
состоянии кнопку Power до тех пор, пока все светодиоды не погаснут, 
после чего отпустите ее.
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Съемка с помощью приемника  
Приемник может быть использован для проведения статической, 
кинематической и кинематической в реальном времени (RTK) съемок.  

 ПРИМЕЧАНИЕ 

Санитарно-гигиенические нормы эксплуатации 
радиосредств выполняются на удалении более 25 см от 
антенны радиомодема. 

Статическая съемка 
Статическая съемка является классическим методом съемки, хорошо 
подходящим для всех размеров базисов (коротких, средних и длинных). По 
крайней мере, две антенны приемников, центрированные над пунктами, 
одновременно собирают измерительные данные на концах базиса в 
течение некоторого периода времени. Эти два приемника должны 
одновременно отслеживать четыре (или более) спутника, записывать 
данные с одинаковым периодом и иметь одинаковые значения угла 
предельного возвышения. Продолжительность сеанса измерений может 
варьироваться от нескольких минут до нескольких часов. Оптимальная 
продолжительность сессии обсервации определяется опытным путем и 
зависит от следующих факторов: 

• Длины измеряемой базовой линии. 
• Количества спутников в поле зрения. 
• Геометрического фактора (Dilution of Precision, DOP). 
• Расположения антенны. 
• Уровня активности ионосферы. 
• Типа используемых приемников. 
• Требований по точности. 
• Необходимости разрешения неоднозначности фазы несущей. 

В общем случае, одночастотные приемники используются для базовых 
линий, длина которых не превышает 15 км.  Для базовых линий длиной 
свыше 15 км следует применять двухчастотные приемники. 
Двухчастотные приемники имеют два больших преимущества. Во-первых, 
измерения по двум частотам позволяют почти полностью устранить 
ионосферные погрешности измерениях фазы кода и несущей, обеспечивая 
большую точность, чем одночастотные приемники при определении 
длинных базисов и во время повышенной активности ионосферы 
(ионосферных штормов). Во-вторых, двухчастотным приемникам требуется 



Установка и съемка 

 HiPer XT- Руководство пользователя 3-6 

значительно более короткие сеансы измерений для получения определений 
заданной точности. 
После окончания съемки данные, собранные приемниками, могут быть 
загружены в компьютер и обработаны с помощью программного 
обеспечения постобработки (например, Topcon Tools). 
Указанная ниже последовательность действий описывает статическую 
съемку с использованием MINTER. 
1. Соедините приемник с компьютером. Эта процедура описана в разделе 

“Подключение приемника к персональному компьютеру” на стр.2-10. 
2. Запустите программу PC-CDU, выберите пункт меню Configuration  > 

Receiver > MINTER и задайте перечисленные ниже параметры, после 
чего щелкните на кнопке Apply (Применить), см. рис. 3-2: 

• Recording interval (Интервал записи) – 15 секунд. 

• Elevation Mask for log file (минимальный угол возвышения для 
записи в файл) – 15 градусов 

• File name prefix (Префикс имени файла) – последние 3 цифры 
серийного номера приемника. 

• LED blink mode switch (Переключатель режима светодиода) - 
разрешите начало и останов записи данных статической съемки с 
помощью кнопки FN. 

 
Рисунок 3-2. Конфигурирование MINTER 

3. Выберите вкладку Advanced (Расширенные функции), а затем вкладку 
Multipath (Многолучевость), выберите перечисленные ниже поля, после 
чего щелкните на кнопке Apply (Применить), см. рис. 3-3: 
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• Code multipath reduction (подавление многолучевости в измерении 
по коду). 

• Carrier multipath reduction (подавление многолучевости в 
измерении по фазе несущей). 

 
Рисунок 3-3. Настройка подавления многолучевости 

4. Выберите вкладку Loop Management (Настройка петель слежения) и 
выберите указанные ниже поля и щелкните на кнопке Apply 
(Применить), см. рис. 3-4: 
• Enable Co-op tracking (Разрешить Совместное слежение). 
• Static Mode (Статический режим). 

 
Рисунок 3-4. Настройка петель слежения 

5. Установите антенны и приемники согласно разделу “Установка 
приемника” на стр. 3-1. 

6. Начните съемку. 
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Кинематическая съемка 
При кинематической съемке стационарный приемник (базовая станция) 
устанавливается на точку c известными координатами (например, 
геодезический пункт). Приемник непрерывно отслеживает спутники и 
сохраняет данные измерений в своем запоминающем устройстве. 
Подвижный приемник устанавливается в неизвестной точке и собирает 
данные в статическом режиме в течение от 2 до 10 минут. После окончания 
съемки на точке подвижную станцию следует перевести в кинематический 
режим и переместить в новую точку съемки. В этой точке и во всех 
последующих приемник переводится в режим статической съемки для 
сбора данных. Таким образом, при движении подвижная станция работает в 
кинематическом режиме, а во время сбора данных - в статическом режиме. 
1. С помощью PC-CDU настройте базовую станцию согласно разделу 

“Статическая съемка” на стр. 3-5. 
2. Выберите пункт меню Configuration  > Receiver > MINTER и задайте 

перечисленные ниже параметры, после чего щелкните на кнопке Apply 
(Применить), см. рис. 3-5: 
• В области FN key mode (режим кнопки FN), выберите режим 

Occupation mode switch (Переключатель режима съемки). 
• В области Initial data collection dynamic mode (Исходный режим 

съемки) выберите режим Kinematic (Кинематический). 
В табл. 4-1 на стр. 4-5 приведены функции кнопки FN и режимы работы 
светодиода REC. 

 
Рисунок 3-5. Конфигурация MINTER подвижной станции 

 ПРИМЕЧАНИЕ 
Обратите внимание, что  базовая и подвижная станции 
должны собирать данные от одних и тех же спутников при 
одинаковом периоде записи данных и при одинаковых 
установках угла минимального возвышения. 



 Съемка с помощью приемника 

P/N 7010-0713 3-9 

3. Установите подвижную станцию в определяемой точке и нажмите кнопку 
Power (питание). Собирать измерительные данные следует в течение 2 
–10 минут. Светодиод REC должен будет светиться оранжевым цветом.  

4. Проверьте индикацию светодиода STAT для отслеживаемых спутников. 
5. После завершения сеанса наблюдений нажмите кнопку FN более чем на 

секунду для перевода подвижной станции в кинематический режим. 

 
СОВЕТ 

Обратите внимание на то, что светодиод REC вспыхивает 
зеленым цветом в динамическом режиме съемки, оранжевым 
в статическом. 

6. Переместите подвижную станцию на следующую точку съемки и 
нажмите кнопку FN менее чем на секунду для того, чтобы перевести ее в 
статический режим. Собирайте данные в течение 2-10 минут. 

7. Повторяйте шаги пять и шесть до тех пор, пока не будет проведена 
съемка во всех точках. Время работы на точке зависит от факторов, 
перечислены для статического метода съемки. 

8. Для завершения работы нажмите и удерживайте кнопку FN от 1 до 5 
секунд для прекращения записи данных. Если это необходимо, 
выключите подвижную станцию. 

Этот метод GPS-съемки позволяет оператору уменьшить время 
пребывания на точке, предоставляя полевой бригаде возможность провести 
съемку значительно большего количества пунктов, чем статическим 
методом. 

Кинематическая съемка в реальном 
времени 
Кинематическая съемка в реальном времени (RTK) реализует разностный 
(относительный) способ местоопределения по сигналам спутниковых 
навигационных систем, в котором дифференциальные поправки  
передаются от базовой станции одной или нескольким подвижным 
станциям с тем, чтобы они производили местоопределение в режиме 
реального времени. 

Установка базовой станции RTK 
Для настройки базовой станции RTK с помощью программы PC-CDU 
проделайте следующее: 
1. Установите антенну приемника базовой станции, как описано в разделе 

“Установка приемника” на стр. 3-1. 
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2. Нажмите кнопку Power (питание) на приемнике.  
3. Проверьте индикацию светодиода STAT для отслеживаемых спутников. 
4. Подключите приемник к компьютеру. Описание этой процедуры 
приведено в разделе  «Подключение приемника к персональному 
компьютеру” на стр. 2-10. 

5. Выберите пункт меню Configuration > Receiver (Настройка > 
Приемник). 

6. Щелкните на кнопке Set all parameters to defaults (Принять начальные 
значения для всех параметров), см. рис. 3-6. 

 
Рисунок 3-6. Кнопка Set all parameters to defaults 

7. В окне Receiver Configuration (Настройки приемника) выберите 
вкладку MINTER и задайте нужные установки. Более подробно об этом 
написано в руководстве пользователя PC-CDU.  

8. Выберите вкладку Positioning (Местоопределение) и установите 
значение 15 градусов для параметра Elevation mask (Минимальный угол 
возвышения), см. рис. 3-7, затем щелкните на кнопке Apply (Применить). 

 
Рисунок 3-7. Настройка приемника – минимальный угол возвышения 

9. Выберите вкладку Base (базовая станция), установите перечисленные 
ниже параметры см. рис. 3-8 и щелкните на кнопке Apply (Применить): 
• GPS/GLO at one time (GPS и ГЛОНАСС одновременно) – выбрать. 



 Съемка с помощью приемника 

P/N 7010-0713 3-11 

• Antenna position (Координаты антенны) – введите широту, долготу 
и высоту фазового центра антенны. Это можно проделать одним из 
перечисленных ниже способов: 

- Если координаты известны, введите значения в эти поля. 
- Выберите поле Averaged (Осреднение) и введите значение 

Averaged Span (Интервал осреднения) в секундах, после чего 
щелкните на кнопке Apply (Применить). Выберите пункт меню 
Tools > Reset receiver (Инструменты > Перезапуск 
приемника) и подождите, пока не пройдет заданный интервал 
времени. После этого координаты станции на вкладке Base 
должны соответствовать координатам, полученным после 
осреднения. Если координаты отображаются как нули, 
щелкните на кнопке Refresh (Обновить). 

- Щелкните на кнопке Get from receiver (Получить из 
приемника). 

 ПРИМЕЧАНИЕ 

Координаты антенны, задаваемые на этой вкладке, 
относятся к фазовому центру антенны на L1. 

 
Рисунок 3-8. Настройка базовой станции 

10. Выберите вкладку Ports (Порты) и установите перечисленные ниже 
параметры последовательного порта (см. рис. 3-9): 
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• Output (Выход) - выберите тип и формат дифференциальных 
поправок из выпадающего списка. 

• Period (Период) в секундах - введите интервал, с котором приемник 
будет выдавать дифференциальные поправки.  

• Baud rate (Скорость) – выберите скорость последовательного 
порта, соединяющего приемник и модем, из выпадающего списка. 

• RTS/CTS – при выборе этого поля используется аппаратное 
квитирование последовательного порта, соединяющего приемник и 
модем. 

 
СОВЕТ 

Скорость передачи данных должна совпадать со скоростью 
передачи данных по эфиру. 

 
Рисунок 3-9. Настройка базовой станции – порты 

11. Щелкните на кнопке Apply (Применить). Приемник начинает посылать 
данные на выбранный порт.  

Более подробно настройка базовой станции описана в “Руководстве 
пользователя PC-CDU”. 
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Установка подвижной станции RTK  
Приведенная ниже последовательность действий позволяет подготовить к 
работе подвижную станцию RTK. Предполагается, что модем Вы уже 
запрограммировали. 
На рис. 3-10 показан комплект аппаратуры подвижной станции RTK с 
внешним контроллером. 

 
Рисунок 3-10. Комплект подвижной станции 

1. Установите антенну приемника подвижной станции как это описано в 
разделе “Установка приемника” на стр. 3-1. 

2. Подключите приемник к компьютеру. Описание этой процедуры 
приведено в разделе  «Подключение приемника к персональному 
компьютеру” на стр. 2-10. 

3. Выберите пункт меню Configuration > Receiver. 
4. Выберите вкладку Positioning (Местоопределение) и установите 
значение 15 градусов для параметра Elevation mask (Минимальный угол 
возвышения), см. рис. 3-7 на стр. 3-10. 



Установка и съемка 

 HiPer XT- Руководство пользователя 3-14 

5. Выберите вкладку Rover (Подвижная станция) и установите нужный 
Positioning Mode (Режим местоопределения), см. рис. 3-11. 

 
Рисунок 3-11. Настройка подвижной станции 

Настройте перечисленные ниже параметры RTK: 
• В области RTK Parameters (параметры RTK) выберите режим  

Extrapolation (Экстраполяция) для RTK float (кинематический режим) 
или Delay (задержка) для RTK fixed (статический режим). 

- Extrapolation (Экстраполяция) используется для RTK приложений 
с малой задержкой и высоким темпом (> 5 Гц) выдачи данных. 
Подвижная станция будет экстраполировать поправки базовой 
станции по фазе несущей при вычислении своего текущего 
местоположения. 

- Delay (Задержка) применяется для высокоточных RTK 
приложений с периодом обновления места 1 раз в секунду. 
Вычислитель подвижной RTK станции будет вычислять либо RTK 
местоположение с задержкой (на эпоху, к которой относится 
последнее полученное сообщение RTCM/CMR), либо текущее 
автономное местоположение (в процессе ожидания новых 
RTCM/CMR сообщений, приходящих от базовой станции). 

• Выберите Dynamics (динамическую модель) движения антенны в 
процессе RTK - Static (Неподвижная), либо Kinematic (Движущаяся). 

• Задайте Ambiguity fixing level (Управление процессом разрешения 
неоднозначности измерения по фазе несущей), для режима RTK Float 
этот параметр не используется. Выбор этого параметра определяет 
величину доверительного интервала, который служит критерием для 
принятия решения о правильности разрешения неоднозначности по 
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фазе. Значение Low (Низкий) соответствует 95%, Medium (Средний) - 
99,5% и High (Высокий) - 99,9%. Чем выше уровень доверительного 
интервала, тем больше время разрешения целочисленной 
неопределенности (и надежнее полученное местоопределение). 

6. Выберите вкладку Ports (Порты) и установите перечисленные ниже 
параметры последовательного порта (см. рис. 3-12): 
• Input (Вход) - выберите формат дифференциальных поправок из 
выпадающего списка.  

• Period (Период) в секундах – оставьте значение по умолчанию. 
• Baud rate (Скорость) – выберите скорость последовательного порта, 
соединяющего приемник и модем, из выпадающего списка. 

• RTS/CTS – при выборе этого поля используется аппаратное 
квитирование последовательного порта, соединяющего приемник и 
модем. 

 
СОВЕТ 

Скорость передачи данных должна совпадать со скоростью 
передачи данных по эфиру. 

 
Рисунок 3-12. Настройка подвижной станции – порты 

7. Щелкните на кнопке Apply (Применить). 
8. Щелчок на кнопке OK закроет диалоговое окно Receiver Configuration 

(Настройка приемника). 
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9. В главном окне программы (см. рис. 3-13) проверьте поле LQ, чтобы 
убедиться, что приемник принимает дифференциальные поправки. 
Обычно приемник начнет выдавать координаты фазового центра 
антенны вместе с типом решения в пределах 10-30 секунд. Однако при 
использовании радиосредств с расширением спектра только на 
установление связи может понадобиться до 60 секунд.  

 
Рисунок 3-13. Главное окно программы PC-CDU 

Определяемые приемником геодезические координаты фазового центра 
антенны, отображаемые на вкладке Geo, всегда вычисляются в системе 
координат WGS-84 и могут иметь 4 типа решения: 

• Standalone (автономное) – приемник вычисляет трехмерное 
положение в автономном режиме, без использования 
дифференциальных поправок. 

• Code Differential (Дифференциальное по измерениям фазы кода) – 
подвижный приемник вычисляет текущие координаты в 
дифференциальном режиме с использованием измерений фазы кода. 

• RTK float (RTK без целочисленного разрешения неоднозначности)-  
подвижный приемник вычисляет текущие относительные координаты 
в дифференциальном режиме с использованием фазы кода и фазы 
несущей, однако, разрешение неоднозначности фазового измерения 
до целого значения не происходит, а неоднозначность разрешается 
как нецелое число. 

• RTK fixed (RTK с целочисленным разрешением неоднозначности) – 
подвижный приемник вычисляет текущие относительные координаты 
с фиксированием неопределенности в дифференциальном режиме. 

Поле LQ отображает состояние получаемых дифференциальных 
сообщений и содержит следующие данные: 

• Качество линии связи в процентах. 
• Время (в секундах), прошедшее со времени получения последнего 
сообщения. 
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• Общее количество безошибочно полученных сообщений 
(определяется типом получаемых сообщений). 

• Общее количество сообщений, полученных с ошибками 
(определяется типом получаемых сообщений). 

Если приемник не получает дифференциальные поправки или если ни один 
из портов не был настроен для получения дифференциальных поправок, 
поле LQ будет либо пустым, либо отобразит следующее: 100% 
(999,0000,0000).  
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Для заметок: 
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Глава 4  
Работа с системой 
В этой главе описаны стандартные процедуры работы с системой: 

• Использование MINTER. 

• Перегрузка файлов из приемника в компьютер. 

• Удаление файлов из приемника. 

• Проверка и загрузка файлов OAF. 

• Управление файловой системой приемника. 

• Очистка энергонезависимой памяти ОЗУ (NVRAM). 

• Изменение режимов приемника. 

• Проверка текущей версии встроенного программного обеспечения и 
загрузка новой версии встроенного ПО. 

Приемники Topcon разработаны таким образом, что работа с ними 
одинакова независимо от типа приемника. Специфичные для приемников 
HiPer XT процедуры отмечены особо.
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Использование MINTER 
MINTER (Рис. 4-1) представляет  собой Минимальный  интерфейс фирмы 
TOPCON, используемый для отображения и управления входными и 
выходными данными во всех приборах семейства HiPer. 

 
Рисунок 4-1. MINTER 

Кнопка POWER (Питание) 
С помощью кнопки POWER (питание) приемник можно включить и 
выключить. 

Светодиоды состояния 
• Когда приемник включен, но спутники не отслеживаются, светодиод 

STAT вспыхивает красным цветом. 

• Когда спутники отслеживаются, светодиод STAT вспыхивает 
зеленым цветом по числу отслеживаемых GPS спутников, 
оранжевым - по числу отслеживаемых ГЛОНАСС спутников.
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Кнопка RESET (Перезапуск) 
Нажатие и удерживание кнопки RESET (Перезапуск) в нажатом состоянии 
около секунды приводит: 

• к перезапуску приемника. 

• к выходу приемника из режима сверхнизкого энергопотребления 
(Zero Power Mode) в обычный режим (Normal Mode). 

 ПРИМЕЧАНИЕ 

Используйте эту кнопку только при условии, что приемник 
не реагирует на команды, или не происходит подзарядка 
внутренних батарей (приемник находится в режиме 
сверхнизкого энергопотребления). 

Кнопка FN и светодиод RЕС (Запись) 
В таблице 4-1 на стр. 4-5 приведены функции кнопки FN и состояние 
светодиода REC (Запись). Назначение функций кнопке FN описано в 
пункте “Параметр FN key mode (Функция кнопки FN)” на стр. 2-23. 

• Нажатием кнопки FN менее чем на 1 секунду можно переключать 
режимы отображения (нормальный и расширенный) или выбирать 
режим записи для статической и динамической постобработки в 
зависимости от настроек приемника. 
В течение первой секунды после нажатия кнопки FN светодиод 
светится оранжевым цветом. 

• Нажатием кнопки FN на время от одной до пяти секунд можно начать 
или закончить запись данных.  
Во время записи данных светодиод REC светится зеленым цветом.  
Если светодиод записи станет красным, то это означает либо 
переполнение памяти приемника, либо возникновение сбоя системы, 
либо в приемнике установлен неправильный OAF (подробнее см. 
раздел “Файл авторизации опций (OAF)”, стр. 1-16).  

• Всякий раз, когда производится запись данных во внутреннюю 
память приемника, светодиод вспыхивает зеленым цветом. 
Интервал записи данных устанавливается с помощью программы 
PC-CDU. Настройка этого параметра описана в параграфе 
"Параметр Recording interval (Интервал записи)” на стр. 2-20. 
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• Каждый раз, когда Вы начинаете или заканчиваете запись данных, 
либо открывается новый файл, либо данные добавляются в файл с 
заданным названием. Информация о настройке порядка записи 
приводится в параграфах “Параметр Always append to the file (Всегда 
добавлять в файл)” и “Параметр Files creation mode (Режим 
создания файлов)” на стр. 2-21. 

• Нажатием на кнопку FN в течение от 5 до 8 секунд можно установить 
скорость передачи данных 9600 бод для последовательного порта А. 
При нажатом состоянии кнопки FN с пятой секунды светодиод REC  
становится красным. Отпустите кнопку при красном цвете 
светодиода (в течение следующих трех секунд). 
Нажатие кнопки FN на время более восьми секунд не имеет никакого 
эффекта. 

• После загрузки нового программного обеспечения или после очистки 
энергонезависимой памяти приемника, происходит проверка 
внутренней файловой системы приемника. 
Во время выполнения этой процедуры светодиод записи вспыхивает 
оранжевым цветом, при этом доступ в файловую систему с CDU 
(блока управления/индикации), также как и запись данных, 
невозможны. Эта процедура может потребовать от долей секунды до 
нескольких минут, в зависимости от конкретных условий и объема 
внутренней памяти.
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Таблица 4-1. Функции кнопки FN и состояние светодиода REC 

Кнопка FN Светодиод REC Состояние 

Когда запись данных выключена, а кнопка FN …  

Не светится  Запись измерений не 
производится. 

Вспыхивает оранжевым 
цветом 

Происходит тестирование 
внутренней файловой системы Не нажата 

Светится красным цветом 
Отсутствие свободной памяти; 
сбой системы при записи 
данных 

Если режим кнопки FN - LED blink mode switch 
(Переключатель режима светодиода) 

Оранжевый цвет Отпускание кнопки приводит к 
смене режима индикации 

Если режим кнопки FN - Occupation mode switch 
(Переключатель режима съемки) 

Нажата менее 
одной секунды 

Оранжевый цвет Функция не преписана 
Если режим кнопки FN - LED blink mode switch 
(Переключатель режима светодиода) 

Зеленый цвет 
Отпускание кнопки инициирует 
начало записи данных (режим 
постобработки не определен) 

Если режим кнопки FN - Occupation mode switch 
(Переключатель режима съемки) 

Нажата от 1 до 
5 секунд 

Зеленый цвет 

Отпускание кнопки инициирует 
начало записи данных (режим 
кинематической или 
статической постобработки) 

Нажата от 5 до 
8 секунд Красный цвет 

Отпускание кнопки приводит к 
тому, что для 
последовательного порта А 
устанавливается скорость 9600 
бод  

Нажата более 8 
секунд Не светится  Действие не назначено. 
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Таблица 4-1. Функции кнопки FN и состояние светодиода REC (продолжение) 
Кнопка FN Светодиод REC Состояние 

Когда проводится запись данных, а кнопка FN …  

Светится красным цветом
Отсутствие свободной памяти, 
сбой системы при записи 
данных 

Если режим кнопки FN - LED blink mode switch 
(Переключатель режима светодиода) 
Светится зеленым 
цветом  

Начата запись данных (режим 
постобработки не определен) 

Если режим кнопки FN - Occupation mode switch 
(Переключатель режима съемки) 
Светится зеленым 
цветом 

Начата запись данных, режим 
постобработки - кинематический 

Не нажата 

Светится оранжевым 
цветом 

Начата запись данных, режим 
постобработки – статический 

Если режим кнопки FN - LED blink mode switch 
(Переключатель режима светодиода) 
Светится оранжевым 
цветом 

Отпускание кнопки приводит к 
смене режима индикации 

Если режим кнопки FN - Occupation mode switch 
(Переключатель режима съемки) 

Нажата менее 
одной секунды 

Светится оранжевым 
цветом 

Отпускание кнопки 
переключение между режимами  
записи данных (запись для 
постобработки кинематической 
или статической) 

Нажата от 1 до 
5 секунд Не  светится Отпускание кнопки приводит к 

прекращению записи данных 

Нажата от 5 до 
8 секунд Светится красным цветом

Отпускание кнопки приводит к 
тому, что для 
последовательного порта А 
устанавливается скорость 9600 
бод 

Нажатие более 
8 секунд Не  светится  Действие не назначено (запись 

данных продолжается) 
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Светодиод BATT 
Цвет светодиода BATT отображает уровень оставшегося заряда 
встроенной в приемник HiPer XT аккумуляторной батареи. 

• Зеленый  – заряд батарей более 85%. 
• Оранжевый – заряд батарей от 15% до 85%. 
• Красный – заряд батарей менее 15%. 

Частота вспышек светодиода BATT указывает также на источник питания. 

• Постоянное свечение – используется внешний источник питания, 
батареи не заряжаются. 

• Вспышки через интервал в 1 секунду – батареи заряжаются.  
• Вспышки через интервал в 5 секунд – питание приемника 
производится от встроенных батарей. 

• Свечение отсутствует – приемник находится в режиме сверхнизкого 
энергопотребления (Zero Power Mode) или же батареи полностью 
разряжены, источник внешнего питания не подключен. 

 ПРИМЕЧАНИЕ 

Если внутренние батареи полностью разряжены и 
источник внешнего питания не подключен, приемник 
перейдет в режим сверхнизкого энергопотребления для 
предупреждения критического разряда батарей. 
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Светодиод RX 
Цвет светодиода состояния радиомодема указывает на то, подано ли 
напряжение питания на радиомодем, принимает ли он радиосигнал или 
выключен. 
Для УКВ-модема: 

• Не светится – модем выключен. 

• Постоянное красное свечение – модем в режиме передатчика; 
данные передаются. 

• Красно-зеленые вспышки – модем находится в командном режиме. 
Этот режим позволяет оператору посылать команды на модем. 

• Постоянный зеленое свечение – модем в режиме приемника. 

• Постоянное оранжевое свечение – модем получает данные. 

• Красные вспышки – обнаружен сбой. Проверьте состояние антенны 
радиомодема, чтобы убедиться в ее исправности, а также надежном 
и правильном подключении. Убедитесь в том, что возле антенны 
отсутствуют проводящие предметы. 

Для модема GSM: 

• Постоянный оранжевое свечение – модем в состоянии 
инициализации. 

• Зеленые вспышки – модем включен, зарегистрирован в сети и 
ожидает входящих вызовов (Режим подчиненного устройства). 

• Постоянное красное свечение – соединение установлено. 

• Зеленые вспышки – модем находится в командном режиме. 

• Оранжевые вспышки – произошел сбой (ошибка при инициализации, 
неправильный PIN код, и т.д.).  
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Информационные режимы 
В приемнике предусмотрены два информационных режима отображения: 
нормальный и расширенный. 

Нормальный режим отображения 
В нормальном режиме светодиод STAT указывает количество 
отслеживаемых спутников и наличие местоопределения. 

Расширенный режим отображения 
Расширенный режим отображения используется для целей тестирования 
приемника. В этом режиме приемник продолжает работать как обычно. 
Светодиод STAT указывает «расширенную» информацию с помощью 
разграничителя.  
В качестве разграничителя используется хорошо различимая двойная 
вспышка, который показывает суммарный результат цикла проведенных 
тестов. Цвет светодиода для разграничителя определяется цветом 
вспышек, характеризующих произведенные тесты, по следующим 
правилам: 

• Оранжевый – по крайней мере, одна из вспышек была оранжевой. 

• Красный – оранжевых вспышек не было, однако была, по крайней 
мере, одна красная вспышка. 

• Зеленый – во всех остальных случаях. 
За разграничителем следуют шесть вспышек светодиодов, 
соответствующие шести тестам приемника, причем каждая из вспышек 
указывает на следующее: 

Вспышка 1. Достаточно ли данных для местоопределения.  
Вспышка 2. Достаточно ли отношение сигнал/шум в каналах приема  

сигналов GPS (см. табл. 4-2 на стр. 4-10). 
Вспышка 3. Достаточно ли отношение сигнал/шум в каналах приема  

сигналов ГЛОНАСС (см. табл. 4-2 на стр. 4-10). 
Вспышка 4. Смещение частоты встроенного задающего генератора 

относительно номинала менее трех миллионных. 
Вспышка 5. Вариация Аллана встроенного задающего генератора 

менее 2,7*10-10.  
Вспышка 6. Время непрерывного слежения составляет более 15 

минут. 
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Таблица 4-2. Достаточные отношения сигнал/шум 
 

 CA/L1 P/L1 P/L2 

GPS 51 39 39 

ГЛОНАСС  51 49 40 

Цвет вспышек показывает, что данных для теста недостаточно 
(оранжевый), приемник прошел тест (зеленый) или приемник тест не 
прошел (красный). 
1. Для включения режима расширенного отображения нажмите и быстро 

(в пределах одной секунды) отпустите кнопку FN на передней панели 
приемника. 

2. Следите за разграничителем. Все вспышки должны стать зелеными в 
пределах 15 минут после включения питания, если приемник исправен 
и антенна расположена благоприятно. Цветовое кодирование 
результатов тестов и окончательной диагностики: 

• зеленый – тест пройден успешно. 

• оранжевый – тест не закончен. 

• красный – некоторые тесты не прошли 
3. Для переключения в нормальный режим отображения нажмите кнопку 

FN. 

Загрузка файлов в компьютер 
По окончании съемки следует переписать собранные файлы с данными в 
компьютер для хранения, обработки и для создания резервной копии. 
Имейте также в виду, что память приемника может содержать 
ограниченное количество файлов, и объем данных также лимитирован, 
таким образом, загрузка файлов в компьютер предотвратит потери 
файлов измерений.  
После сбора данных на рабочей точке следует загрузить файлы в 
компьютер как можно быстрее. Одной из функций PC-CDU является File 
Manager (Менеджер файлов), позволяющий загружать файлы в компьютер 
и удалять файлы из приемника. 
1. Подключите приемник к компьютеру. Эта процедура описана в разделе 

“Подключение приемника к персональному компьютеру” на стр. 2-10. 
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2. В диалоговом окне Connection Parameters выберите “RTS/CTS 
handshaking” (квитирование RTS/CTS), см. рис. 2-15, и щелкните на 
кнопке Connect (Соединить), см. рис.4-2. 

 
Рисунок 4-2. Параметры соединения – подтверждение использования RTS/CTS 

3. Выберите пункт меню File > File Manager (Файл > Управление 
файлами), затем выберите вкладку Download Path (Директория 
загрузки) в диалоговом окне File Manager, см. рис.4-3. 

 
Рисунок 4-3. Выбор директории загрузки 

4. Выберите уже существующую директорию или создайте новую 
директорию, используя кнопку Create (Создать), для размещения 
файлов. 

5. Выберите вкладку Download files (Файлы, подлежащие загрузке) и 
выберите файл(ы) для загрузки, см. рис. 4-4 на стр. 4-12. 
Для выбора группы файлов удерживайте нажатой клавишу Shift и 
выполняйте щелчки мышью на названиях файлов; при нажатой 
клавише Ctrl щелчки мышью по названию будут выделять отдельные 
файлы. 
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Рисунок 4-4. Файлы, подлежащие загрузке 

6. Щелкните на кнопке Download (Загрузить). В процессе загрузки 
состояние индикаторов отображается слева от файла см. рис. 4-5. 

• Голубой индикатор – файл стоит в очереди на загрузку. 

• Красный индикатор – файл загружается. 

• Зеленый индикатор – файл успешно загружен. 

 
Рисунок 4-5. Загрузка файлов – индикаторы состояния 

7. Щелкните на кнопке Exit (Выход) в диалоговом окне File Manager. 
8. Продолжите выполнять другие операции. Для завершения работы с 

PC-CDU выберите пункт меню File > Disconnect (Файл > 
Отключение), а затем File > Exit (Файл > Выход).
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Удаление файлов 
Для удаления файлов из приемника выполните следующие действия: 
1. Подключите приемник к компьютеру. Эта процедура описана в разделе 

“Подключение приемника к персональному компьютеру” на стр. 2-10. 
2. В диалоговом окне Connection Parameters выберите “RTS/CTS 

handshaking” (квитирование RTS/CTS), и щелкните на кнопке Connect 
(Соединить), см. рис.4-6. 

 
Рисунок 4-6. Параметры соединения – подтверждение использования RTS/CTS 

3. Выберите пункт меню File > File Manager (Файл > Управление 
файлами), затем выберите во вкладке Download files (Файлы, 
подлежащие загрузке) файлы, которые следует удалить, см. рис.4-7.  
Для выбора группы файлов удерживайте нажатой клавишу Shift и 
выполняйте щелчки мышью на названиях файлов; при нажатой 
клавише Ctrl щелчки мышью по названию будут выделять отдельные 
файлы. 

 
Рисунок 4-7. Удаление файлов 
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4. Щелкните на кнопке Delete (Удалить), см. рис. 4-7 на стр. 4-13. 
5. Щелкните на кнопке Yes (Да)  в диалоговом окне подтверждения 

удаления файлов. PC-CDU удаляет выбранные файлы. 
6. Щелкните на кнопке Exit (Выход) в диалоговом окне File Manager. 
7. Продолжите выполнять другие операции. Для завершения работы с 

PC-CDU выберите пункт меню File > Disconnect (Файл > 
Отключение), а затем File > Exit (Файл > Выход). 

Проверка опций приемника 
 

 
СОВЕТ 

Полный перечень опций и их описание Вы можете получить 
у своего дистрибьютора. 

Вы можете проверить состояние опций приемника и загрузить новый OAF 
с помощью кабеля RS 232, компьютера и PC-CDU. Более полное описание 
программного обеспечения PC-CDU приведено в «Руководстве 
пользователя PC-CDU”. 
1. Подключите приемник к компьютеру. Эта процедура описана в разделе 

“Подключение приемника к персональному компьютеру” на стр. 2-10. 
2. Выберите пункт меню Tools > Receiver Options (Инструменты > 

Опции приемника), см. рис. 4-8. 

 
Рисунок 4-8. Выбор пункта меню Receiver options 

В диалоговом окне Options Manager (Управление опциями), см. рис. 4-9 
на стр. 4-15, содержится следующая информация: 

• Option Name (Название опции) – Название/описание  опции. 

• Current (Текущий) – текущее состояние опции. 

• Purchased (Приобретенный) – приобретена опция или нет. 

• Leased (Арендованный) - арендована опция или нет.
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• Expiration date (Дата окончания действия) – дата, когда опция будет 
отключена, если действие опции ограничено по времени. 

Опции могут быть как приобретены, так и арендованы, столбец Current 
(Текущее) отображает ее текущее состояние. Значения опций могут быть: 

• 1 или “-----“ -  встроенное программное обеспечение не 
поддерживает опцию. 

• 0 – опция приемника отключена. 
• Положительное целое число – опция включена. 
• Yes (Да) - опция включена 
• No (Нет) – опция не включена. 

 
Рисунок 4-9. Окно Option Manager 

3. После завершения работы щелкните на кнопке Exit (Выход) в 
диалоговом окне Options Manager, затем выберите пункт меню File > 
Disconnect (Файл > Отключение) для предотвращения конфликтов в 
доступе к последовательному порту. 
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Загрузка OAF 
Дистрибьютор Topcon Positioning System обеспечивает пользователей 
файлами OAF (файл авторизации опций). По всем вопросам, касающимся 
OAF, делайте запросы по адресу e-mail survey@prin.ru. Пожалуйста, 
указывайте идентификационный номер (ID) приемника (см. раздел 
“Проверка версии встроенного программного обеспечения” на стр. 4-21). 
1. Для загрузки нового OAF выполните шаги один и два раздела 

“Проверка опций приемника” на стр. 4-14. 
2. Щелкните на кнопке Load (Загрузить), расположенной в нижней части 

диалогового окна Options Manager (Управление опциями), см. Рис. 
4-9 на стр. 4-15. 

3. Выберите директорию, где находится новый файл авторизации опций 
OAF. Эти файлы имеют расширения .jpo или .tpo и уникальны для 
каждого приемника (см. рис. 4-10). 

 
Рисунок 4-10. Загрузка OAF 

4. Выберите соответствующий файл и щелкните на кнопке Open 
(Открыть) (см. рис. 4-10). Новая опция приемника загрузится в 
приемник и таблица в диалоговом окне Option Manager  обновится.  

5. После завершения работы щелкните на кнопке Exit (Выход) в 
диалоговом окне Options Manager, затем выберите пункт меню File > 
Disconnect (Файл > Отключение) для предотвращения конфликтов в 
доступе к последовательному порту.  
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Организация памяти 
приемника 
При использовании приемника в статических и динамических приложениях 
Вам может понадобиться оценить размер файлов с данными измерений, 
которые записываются в приемник. Конкретный размер файла зависит от 
типа записываемых данных. Приближенный расчет размеров таких 
файлов можно произвести по формулам , приведенным ниже. Эти 
соотношения основаны на размере сообщений, записываемых по 
умолчанию. 

• SS – ориентировочный размер записи одной эпохи данных в файле с 
измерительной информацией (выражается в байтах). 

• N – число спутников, которые отслеживаются в этой эпохе. 
При записи данных только по L1: 

SS = 183+22*N 
При записи данных по L1 и L2: 

SS = 230 + 44*N 

Очистка энергонезависимой 
памяти NVRAM 
В энергонезависимом оперативном запоминающем устройстве приемника 
хранятся данные, необходимые для слежения за спутниками (эфемериды 
и координаты приемника). Энергонезависимое ОЗУ хранит также текущие 
установки приемника, такие как сведения об антенне, угол минимального 
возвышения и интервал записи, а также данные о внутренней файловой 
системе приемника. 
Хотя очистка энергонезависимого ОЗУ не является часто используемой 
(или даже рекомендуемой при нормальных условиях) операцией, однако 
встречаются ситуации, когда очистка энергонезависимого ОЗУ может 
устранить проблемы слежения за спутниками и обмена по интерфейсным 
портам. Очистку энергонезависимого ОЗУ приемника можно сравнить с 
перезагрузкой персонального компьютера.  
После очистки энергонезависимого ОЗУ приемнику потребуется около 15 
минут для получения новых эфемерид и альманаха. 
В ходе очистки энергонезависимого ОЗУ приемника не происходит 
удаления каких-либо файлов, уже записанных в память приемника. 
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Очистка приводит к переустановке настроек приемника к первоначальным 
заводским значениям. 
Следует отметить, что после очистки энергонезависимого ОЗУ в течение 
нескольких секунд светодиод STAT вспыхивает оранжевым цветом, 
показывая, что приемник сканирует память, проверяя файловую систему. 

Использование MINTER для очистки 
энергонезависимого ОЗУ 
1. Нажмите и отпустите кнопку Power для того чтобы выключить 

приемник.  
2. Нажмите и не отпускайте кнопку FN. 
3. Нажмите и удерживайте кнопку Power примерно в течение 1 секунды. 

Отпустите кнопку питания, кнопку FN следует удерживать в нажатом 
состоянии. 

4. Подождите, пока светодиоды STAT и REC не станут зелеными. 
5. Подождите, пока светодиоды STAT и REC не начнут вспыхивать 

оранжевым цветом. 
6. Отпустите кнопку FN при вспыхивающих оранжевым цветом 

светодиодах STAT и REC. 

Использование PC-CDU для очистки 
энергонезависимого ОЗУ 
1. Подключите приемник к компьютеру. Эта процедура описана в разделе 

“Подключение приемника к персональному компьютеру” на стр. 2-10. 
2. Выберите пункт меню Tools > Clear NVRAM (Инструменты > 

Очистить энергонезависимое ОЗУ), см. рис. 4-11. Светодиод REC 
будет вспыхивать зеленым и красным цветом; светодиод STAT - 
красным. 

 
Рисунок 4-11. Очистка ОЗУ с помощью PC-CDU 

После окончания очистки приемник автоматически разорвет соединение с 
компьютером.
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Изменение режимов 
приемника 
Приемник HiPer XT может находиться в четырех особых режимах, два из 
них – режимы отображения, а два других - режимы энергосбережения: 

• Нормальный режим отображения. 

• Расширенный режим отображения. 

• Спящий режим. 

• Режим сверхнизкого энергопотребления. 
Описание нормального и расширенного режимов отображения приводится 
в разделе “Информационные режимы” на стр. 4-9. 

Спящий режим 
В спящем режиме плата питания и модуль Bluetooth продолжают 
потреблять энергию батарей, разряжая их через некоторое время. Для 
предотвращения этого переведите приемник в режим сверхнизкого 
энергопотребления (см. раздел “Режим сверхнизкого энергопотребления” 
на стр. 4-20). Для перевода приемника в спящий режим выполните 
перечисленные ниже действия: 
1. Включите приемник. 
2. Нажмите и удерживайте кнопку Power (питание) от 4-х, но не более 8-и 

секунд. 
3. После того, как светодиоды REC и STAT станут оранжевыми 

одновременно, отпустите кнопку Power (питание). Приемник перейдет в 
спящий режим. 

4. Любые данные, поступающие по портам RS232 , приведут приемник в 
рабочее состояние. 

 ПРИМЕЧАНИЕ 

Если Вы удерживаете кнопку Power более 14-и секунд, это 
нажатие будет проигнорировано (защита от западания 
кнопки).
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Режим сверхнизкого 
энергопотребления 
Когда приемник отключен, то даже в спящем режиме плата питания будет 
продолжать потреблять энергию батарей. Это приведет к тому, что даже 
полностью заряженная батарея приемника, находящегося на складском 
хранении, полностью разрядится менее чем через два месяца. Для того 
чтобы предотвратить расходование энергии батарей платой питания, 
следует перевести приемник в режим сверхнизкого энергопотребления. 
1. Включите приемник. 
2. Нажмите и удерживайте кнопку Power (питание) не менее 8-и, и не 

более 14-и секунд. 
3. Когда оба светодиода станут красными, отпустите кнопку Power. После 

того, как светодиоды погаснут, приемник перейдет в режим 
сверхнизкого энергопотребления. 

4. Чтобы вернуть приемник в нормальный режим, нажмите кнопку RESET 
(Перезапуск) примерно на 1 секунду. 

 ПРИМЕЧАНИЕ 

Если внутренние батареи полностью разрядились, и 
внешний источник питания не подключен, приемник 
перейдет в режим сверхнизкого энергопотребления 
самостоятельно (для предотвращения глубокого разряда 
батарей).
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Проверка версии встроенного 
программного обеспечения 
Узнать номер версии встроенного программного обеспечения приемника 
можно с помощью программы PC-CDU. 
1. Подключите приемник к компьютеру. Эта процедура описана в разделе 

“Подключение приемника к персональному компьютеру” на стр. 2-10. 
2. Выберите пункт меню Help > About (Помощь > О программе). 

Откроется диалоговое окно About PC-CDU (см. рис. 4-12). 

 
Рисунок 4-12. О PC-CDU 

В диалоговом окне About PC-CDU приведена важная информация об  
аппаратных средствах и встроенном программном обеспечении. В этом 
перечне приводится перечисленные ниже, сведения, которые могут 
понадобиться при обращении в техническую поддержку. 

• Модель приемника. 

• Идентификационный код приемника. 

• Версия программного обеспечения.  
3. После завершения работы щелкните на кнопке Exit (Выход) в 

диалоговом окне Options Manager, затем выберите пункт меню File > 
Disconnect (Файл > Отключение) для предотвращения конфликтов в 
доступе к последовательному порту.
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Загрузка нового встроенного 
программного обеспечения 
Приемники базовой и подвижной станции должны управляться 
встроенным программным обеспечением той же самой версии. Получить 
последнюю версию встроенного программного обеспечения можно через 
службу технической поддержки. 

 ПРИМЕЧАНИЕ 

В приемнике HiPer XT следует использовать встроенное 
программное обеспечение версии 2.5p1 или новее. 

 ОСТОРОЖНО 

Не используйте программное обеспечение версии 2.4 
или более ранней версии. 

Плата приемника и плата питания должны быть загружены программным 
обеспечением из одного пакета. Программное обеспечение модуля 
Bluetooth не зависит от платы приемника и платы питания и относится к 
другому пакету встроенных программ. 
Для загрузки программного обеспечения в платы приемника и питания в 
приемнике используется программа FLoader, работающая из ОС Windows. 
Более подробно эта программа описана в “Руководстве пользователя 
FLoader”. 
1. Установите программу FLoader. 
2. Получите новый пакет встроенного программного обеспечения в 

службе технической поддержки и скопируйте его в компьютер. 
3. Подключите приемник к компьютеру. Эта процедура описана в разделе 

“Подключение приемника к персональному компьютеру” на стр. 2-10. 
4. Запустите программу FLoader. 
5. Во вкладке Connection (Соединение) выберите последовательный порт 

на компьютере, к которому подстыкован кабель связи с приемником, и 
выберите скорость передачи данных (обычно 115200 Бод), см. рис. 4-
13 на стр. 4-23. 



Загрузка нового встроенного программного обеспечения 

P/N 7010-0713 4-23 

 
Рисунок 4-13. Главный экран программы FLoader 

В следующих разделах описана процедура загрузки встроенного 
программного обеспечения. 

Встроенное программное 
обеспечение платы приемника и 
платы питания 
Программное обеспечение платы приемника и платы питания 
распространяется в виде архивного файла, который следует распаковать 
перед загрузкой в приемник. Этот файл содержит следующие три файла: 

• ramimage.ldr – файл-образ ОЗУ платы приемника 

• main.ldp – файл-образ флэш-памяти платы приемника 

• powrbrd.ldr – файл-образ ОЗУ платы питания 

 ПРИМЕЧАНИЕ 

При загрузке нового программного обеспечения Вы должны 
загрузить все три файла. Эти файлы должны быть взяты 
из одного пакета программного обеспечения. 

1. В программе FLoader выберите вкладку Device, в ней выберите 
значение Receiver (Приемник) для поля Device Type (Тип 
устройства). После этого щелкните на кнопке Get from Device 
(Опросить устройство) для получения сведений об устройстве, см. 
рис. 4-14 на стр. 4-24.  
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Рисунок 4-14. Установка типа устройства - Receiver 

2. Выберите вкладку Program (Программа) и выберите значение Soft 
Break Capture для поля Capture Method, см. рис. 4-15. 

 
Рисунок 4-15. Вкладка Program 

3. Выберите файлы для ОЗУ и флэш-памяти платы приемника, см. рис. 
4-15. 

4. Щелкните на кнопке Load (Загрузить) и подождите, пока файлы не 
будут загружены в приемник полностью. 

 ПРИМЕЧАНИЕ 

Если Вы выбрали неправильный файл, в нижней части 
диалогового окна появится сообщение об ошибке. 
Выберите правильный файл. 
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5. Выберите вкладку Device, в ней выберите значение Receiver’s Power 
Board (Плата питания приемника) для поля Device Type (Тип 
устройства). После этого щелкните на кнопке Get from Device 
(Опросить устройство) для получения сведений об устройстве, см. 
рис. 4-16.  

 
Рисунок 4-16. Установите тип устройства – Receiver’s Power Board 

6. Выберите вкладку Program (Программа) и выберите значение Soft 
Break Capture для поля Capture Method, см. рис. 4-17. 

 
Рисунок 4-17. Вкладка Program 

7. Выберите файл для ОЗУ платы питания см. рис. 4-17. 
8. Щелкните на кнопке Load (Загрузить) и подождите, пока файл не 

будет загружен в приемник полностью. 

 ПРИМЕЧАНИЕ 

Если Вы выбрали неправильный файл, в нижней части 
диалогового окна появится сообщение об ошибке. 
Выберите правильный файл. 
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9. Выберите пункт меню File > Exit (Файл > Выход). 
10. Очистите энергонезависимую память (см. раздел “Очистка 

энергонезависимой памяти NVRAM” на стр. 4-17) и обновите альманах 
(см. раздел “Сбор альманахов” на стр. 2-46). 

Программное обеспечение модуля 
Bluetooth 
Программное обеспечение модуля Bluetooth распространяется в виде 
архивного файла, который следует распаковать перед загрузкой в 
приемник. Этот файл содержит следующие два файла: 

• btloader.ldr – файл-образ ОЗУ модуля Bluetooth. 
• btmain.ldp – файл-образ флэш-памяти модуля Bluetooth. 

 ПРИМЕЧАНИЕ 

При загрузке нового программного обеспечения Вы должны 
загрузить оба файла. Эти файла должны быть взяты из 
одного пакета программного обеспечения. 

1. В программе FLoader выберите вкладку Device, в ней выберите 
значение Receiver (Приемник) для поля Device Type (Тип устройства). 
После этого щелкните на кнопке Get from Device (Опросить 
устройство) для получения сведений об устройстве, см. рис. 4-18. 

 
Рисунок 4-18. Установите тип устройства - Receiver 

2. Выберите вкладку Program (Программа) и выберите значение Soft 
Break Capture для поля Capture Method, см. рис. 4-19 на стр. 4-27. 

3. Выберите файлы для ОЗУ и флэш-памяти платы модуля Bluetooth, см. 
рис. 4-19 на стр. 4-27. 
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Рисунок 4-19. Установки вкладки Program (программа) 

4. Щелкните на кнопке Load (Загрузить) и подождите, пока файлы не 
будет загружены в приемник полностью, см. рис. 4-20. 

 
Рисунок 4-20. Загрузка программного обеспечения модуля Bluetooth завершено 

 ПРИМЕЧАНИЕ 

Если Вы выбрали неправильный файл, в нижней части 
диалогового окна появится сообщение об ошибке. 
Выберите правильный файл. 

5. Выберите пункт меню File > Exit (Файл > Выход). 
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Для заметок: 
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Глава 5  
Устранение 
неисправностей 
При соблюдении инструкции по обслуживанию и безопасной 
эксплуатации, приведенных в этом руководстве, возникновение отказов 
приемника маловероятно. Эта глава поможет Вам провести 
диагностирование и устранить некоторые характерные неисправности, с 
которыми Вы можете встретиться при эксплуатации приемника. 

 
ПРЕДУПРЕЖДЕНИЕ

Не пытайтесь ремонтировать приемник самостоятельно. 
Попытка ремонта лишает Вас гарантийного 
обслуживания и может привести к повреждению 
прибора. 

Проверьте прежде всего! 
Перед тем, как обратиться в отдел технической поддержки пользователей  
TPS, проделайте следующее: 

• Во-первых, тщательно проверьте все соединения приемника с 
внешними устройствами, чтобы убедиться в их правильности и 
надежности. 

• Во-вторых, неоднократно проверьте кабели на предмет их 
повреждения или изношенности. 

• Ознакомьтесь со следующими ниже разделами. 
Если неисправность не устраняется, попытайтесь сделать следующее:  

• Проведите перезагрузку приемника с помощью PC-CDU, пункт меню 
Tools > Reset receiver (Инструменты > Перезагрузка приемника). 

• Используя PC-CDU, восстановите начальные заводские установки 
(выберите пункт меню Configuration > Receiver (Настройка > 
Приемник), в появившемся окне щелкните на кнопке Set all 
parameters to defaults (Принять начальные значения для всех 
параметров). 

• Очистите энергонезависимое ОЗУ (см. раздел “Очистка 
энергонезависимой памяти NVRAM” на стр. 4-17). 

• Проведите инициализацию файловой системы -выберите пункт 
меню Tools > Initialize file system (Инструменты > Инициализация 
файловой системы). Это действие удаляет все файлы с 
измерениями, содержащимися в приемнике.
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Отказы системы питания 
Заводской установкой режима работы источника питания и зарядного 
устройства является Auto (Автоматический). Для того чтобы проверить 
эту установку, проделайте следующее: 
1. Подключите приемник к компьютеру. Эта процедура описана в разделе 

“Подключение приемника к персональному компьютеру” на стр. 2-10. 
2. Выберите пункт меню Configuration > Receiver. 
3. Во вкладке General проверьте установки областей Power (Питание) и 

Charger (Зарядное устройство). В них должна быть выбрана 
установка Auto. Если это не так, измените их на Auto и щелкните на 
кнопке Apply (Применить). 

 
СОВЕТ 

Очистка энергонезависимого ОЗУ вернет приемник к режиму 
AUTO (см раздел “Очистка энергонезависимой памяти 
NVRAM” на стр. 4-17). 

Отказ 

Отсутствует питание приемника  

Причина Способ устранения 
Приемник может находиться 
в режиме сверхнизкого 
энергопотребления 

Нажмите кнопку RESET (Перезапуск) 

Если не используется 
внешний источник питания, 
могут быть разряжены 
батареи  

Подключите полностью заряженный 
внешний источник питания и повторно 
включите приемник. См. раздел 
“Подключение приемника к источнику 
питания” на стр. 2-2. 

Приемник подключен к 
внешнему источнику 
питания, но внутренние 
батареи разряжены  

Поставьте батареи на подзарядку на всю 
ночь. См. раздел “Подключение 
приемника к источнику питания” на стр. 2-
2. 

Неисправное зарядное 
устройство или неисправные 
батареи 

Если после подзарядки внутренних 
батарей (приемник следует заряжать 8 
часов) питание приемника отсутствует, 
обратитесь в службу технической 
поддержки.  
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Отказы приемника 
Ниже описаны наиболее часто встречающиеся отказы приемника и 
способы из устранения. 

Отказ 

Приемник не может установить соединение с компьютером или внешним 
контроллером   

Причина Способ устранения 
Интерфейсный 
кабель 
подсоединен 
неправильно. 

• Удостоверьтесь в том, что кабельный разъем 
был подключен к правильному 
последовательному порту. 

• Отсоедините кабель, а затем надлежащим 
образом вновь подстыкуйте его к разъему 
приемника. 

• Ознакомьтесь с описаниями “Внешние 
компоненты” на стр. 1-13 и “Разъем 
последовательного порта” на стр. A-11. 

Кабель поврежден. Замените кабель на исправный. Для приобретения 
кабеля обратитесь к продавцу оборудования.  

Используемый для 
связи порт 
приемника не  
находится в 
командном режиме. 

1. Подключите приемник к компьютеру, используя 
свободный порт (см. раздел “Подключение 
приемника к персональному компьютеру” на 
стр. 2-10) и запустите PC-CDU. 

2. Выберите пункт вкладку  
Configuration > Receiver > Ports. 

3. Измените входной режим  для используемого 
для связи последовательного порта на 
командный (Command).  

Отказ 

Приемник не захватывает спутниковые сигналы в течение 
продолжительного времени 

Причина Способ устранения 

В приемнике 
хранится старый 
альманах 

• Обновите альманах 
• См. раздел “Сбор альманахов” на стр. 2-46. 
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Отказ 

Приемник отслеживает слишком мало спутников   

Причина Способ устранения 
Слишком большое 
значение угла 
минимального 
возвышения (например, 
больше 15 градусов)  

• Уменьшите значение угла минимального 
возвышения. 

• Информация по установке угла 
минимального возвышения приведена на 
стр. 2-20. 

Съемка проводится 
вблизи объектов, 
загораживающих небо 
(густая листва деревьев, 
высокие здания и т.п.) 

• Проверьте, задействованы ли средства 
подавления многолучевости: 

1. Подключите приемник к компьютеру, 
(см. раздел “Подключение приемника 
к персональному компьютеру” на стр. 
2-10) и запустите PC-CDU. 

2. Выберите вкладку 
Configuration>Advanced>Multipath 
Reduction и включите обе кнопки-
флажка. 

• Если возможно, переместитесь на 
открытую местность. 

Отказ 

Приемник не производит местоопределение в дифференциальном 
режиме (по кодовым измерениям или RTK) 

Причина Способ устранения 
Введены неправильные 
координаты базовой 
станции  

С помощью PC-CDU или программного 
обеспечения для управления полевыми 
измерениями задайте правильные 
координаты базовой станции 

Приемник не настроен 
как базовая или 
подвижная станция 

• Если приемник должен работать как 
базовая станция, убедитесь, что он 
настроен соответствующим образом. 
Подробнее см. раздел “Съемка с помощью 
приемника” на стр. 3-5. 

• Если приемник должен работать как 
подвижная станция, убедитесь, что он 
настроен соответствующим образом. 
Подробнее см. раздел “Съемка с помощью 
приемника” на стр. 3-5.  
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Соответствующие опции 
приемника могут быть 
отключены или истек 
срок их использования. 

• Подробно о проверке текущих опций см. 
раздел в разделе “Проверка опций 
приемника” на стр. 4-14. 

• Активируйте или продлите срок действия 
соответствующей опции приемника, 
заказав и загрузив новый OAF. 

Недостаточное число 
общих спутников. 
Для того чтобы 
разрешить фазовую 
неоднозначность, 
базовая и подвижные 
станции должны 
отслеживать, по 
крайней мере, пять 
общих спутников.  

• Убедитесь, что как подвижная, так и 
базовая станции используют один и тот же 
обновленный альманах. См. раздел “Сбор 
альманахов” на стр. 2-46.. 

• Проверьте угол минимального возвышения 
на подвижной и базовой станций - они 
должны быть одинаковыми. Информация 
по установке угла минимального 
возвышения приведена на стр. 2-20. 

Плохая геометрия 
спутникового созвездия 
(слишком большие 
значения PDOP/GDOP). 

Проводите съемку, когда значения PDOP 
будут низкими. 

Угол минимального 
возвышения превышает 
15 градусов. 

• Уменьшите значение угла минимального 
возвышения. 

• Информация по установке угла 
минимального возвышения приведена на 
стр. 2-20. 

Плохой контакт в кабеле 
антенна-приемник. 

• Убедитесь, что кабель не поврежден. 

• Проверьте надежность подключения 
разъема кабеля к разъему на корпусе 
приемника. Для обеспечения надежного 
соединения отсоедините и повторно 
соедините разъем кабеля. 

Модемы подвижной и 
базовой станций 
настроены на разные 
радиоканалы. 

Следует настроить приемники подвижной и 
базовой станций на один и тот же радиоканал.
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Несоответствие в 
стандартах 
дифференциального 
режима, используемых в 
приемниках подвижной 
и базовой станций   

Убедитесь, что приемники подвижной и 
базовой станций используют один и тот же 
формат дифференциальных поправок: 
1. Подключите приемник к компьютеру, (см. 

раздел “Подключение приемника к 
персональному компьютеру” на стр. 2-10) и 
запустите PC-CDU. 

2. Выберите вкладку Configuration > 
Receiver > Ports и установите один и тот 
же формат дифференциальных поправок 
для обоих приемников. 

Заданная скорость 
передачи данных не 
совместима со 
скоростью передачи 
данных по эфиру 
внешним модемом. 

• Измените скорость передачи данных до 
значения, которое поддерживается 
модемом. Информация о скорости 
передачи данных приведена в Руководстве 
по эксплуатации модема. 

 

Заданная скорость 
передачи данных между 
приемником и модемом 
не поддерживается 
модемом. 

• Измените скорость передачи данных на 
значение, которое поддерживает внешний 
модем. Информация о скорости передачи 
данных приведена в Руководстве по 
эксплуатации модема. 

 

Батарея питания 
внешнего модема 
разряжена. 

• Подключите внешний источник питания к 
приемнику. См. раздел “Внешние батареи” 
на стр. 2-3. 

• См. раздел “Подключение приемника к 
источнику питания“ на стр. 2-2. 

Слишком большое 
расстояние между 
базовой и подвижной 
станциями. 

• Уменьшите дальность между базовой и 
подвижной станциями. 

• Для увеличения радиуса радиопокрытия 
используйте радиомодем-репитер. 
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Отказ 

Приемник не начинает накопление данных. 

Причина Способ устранения 

В памяти 
приемника не 
осталось 
свободного 
пространства для 
записи файлов. 

• Загрузите файлы приемника в компьютер и 
удалите файлы (см. разделы “Загрузка файлов 
в компьютер” на стр. 4-10 и “Удаление файлов” 
на стр. 4-13). 

• Воспользуйтесь функцией AFRM. См. раздел 
“Параметр Automatic File Rotation Mode (AFRM) 
(Режим автоматического создания файлов)” 
на стр. 2-21. 

Во внутренней 
памяти приемника 
уже записано 512 
файлов. 

• Удалите ненужные файлы (см. раздел 
“Удаление файлов” на стр. 4-13). 

• Воспользуйтесь функцией AFRM. См. раздел 
“Параметр Automatic File Rotation Mode (AFRM) 
(Режим автоматического создания файлов)” 
на стр. 2-21. 

 
 

Отказы Bluetooth 
Далее описаны некоторые наиболее часто встречающиеся сообщения об 
ошибках и способы устранения этих ошибок. Эти сообщения программа 
BTCONF выдает в строке состояния.  

Сообщение об ошибке. 

Can’t find receiver (Не могу обнаружить приемник). 

Причина  Способ устранения 
Приемник 
выключен. 

Убедитесь, в наличии питания приемника и в том, 
что он включен.  

При использовании 
кабеля он был 
подсоединен 
неправильно. 

• Удостоверьтесь в том, что кабельный разъем 
был подключен к правильному 
последовательному порту. 

• Отсоедините кабель, а затем надлежащим 
образом вновь подстыкуйте его к разъему 
приемника. 

При использовании 
кабеля он оказался 
поврежденным 

Замените кабель на исправный. Для приобретения 
кабеля обратитесь к Вашему дилеру. 
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Последовательный 
порт компьютера, к 
которому 
подключен 
приемник, не 
соответствует 
выбранному в 
BTCONF. 

Убедитесь, что кабель RS232 подключен к 
последовательному порту, выбранному из 
выпадающего списка портов связи программы 
BTCONF. Подробнее см. раздел “Настройка 
модуля Bluetooth“ на стр. 2-41. 

Используемый для 
связи порт 
приемника не  
находится в 
командном режиме. 

1. Подключите приемник к компьютеру, используя 
свободный порт (см. раздел “Подключение 
приемника к персональному компьютеру” на 
стр. 2-10) и запустите PC-CDU. 

2. Выберите вкладку  
Configuration > Receiver > Ports. 

3. Измените входной режим  для используемого 
для связи последовательного порта на 
командный (Command).  

Были изменены 
установки для 
порта В. 

• Установки для порта В должны быть 
следующими: скорость передачи данных -
115200 бод, 8 битов данных, 1 стоповый бит, 
нет четности и нет подтверждения соединения. 

• Попробуйте активировать квитирование через 
сигналы RTS/CTS для порта В. Не меняйте 
другие установки. 

Соответствующие 
опции приемника 
могут быть 
отключены или 
истек срок их 
использования. 

• Подробно о проверке текущих опций см. 
раздел “Проверка опций приемника” на стр. 4-
14. 

• Активируйте или продлите срок действия 
соответствующей опции приемника, заказав и 
загрузив новый OAF. 

Сообщение об ошибке. 

Can’t find Bluetooth (не могу обнаружить модуль Bluetooth) 

Причина  Способ устранения 

Слот 3 приемника 
выключен. 

1. Соедините компьютер и приемник (см. раздел 
“Установление соединения через RS232” на 
стр. 2-12). 

2. Выберите вкладку Configuration >Receiver > 
General. 

3. В области Turn on/off Slots выставьте флажок 
Slot 3 (B). 
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Модуль Bluetooth 
соединен с другим 
устройством. 

Отключите соединение с устройством, затем 
установите соединение с приемником. 

Процессор модуля 
Bluetooth 
перегружен. 

1. Переведите приемник в режим сверхнизкого 
энергопотребления (см. раздел “Режим 
сверхнизкого энергопотребления” на стр. 4-20). 

2. Нажмите и удерживайте кнопку RESET в 
течение одной секунды, чтобы вернуть 
приемник в нормальный режим. 

3. Повторно подключитесь по Bluetooth. 

В приемнике 
отсутствует модуль 
Bluetooth. 

Обратитесь к продавцу оборудования для 
приобретения приемника, оснащенного 
встроенным модулем Bluetooth.  

Сообщение об ошибке. 

Open COM# port failed: Access is denied. (Сбой во время открытия порта 
COM#: доступ запрещен). 

Причина. Способ устранения. 

Порт компьютера, 
назначенный для 
связи,  занят другой 
программой. 

• Закройте мешающую программу повторите 
попытку соединения. 

• Подключите приемник через свободный порт.  

Отказ 

Поиска доступных устройств не обнаружил приемник. 

Причина. Способ устранения. 

Приемник 
выключен. 

• Проверьте, получает ли приемник питание и 
включен ли он. 

• Проверьте, подключен ли кабель питания к 
порту с меткой “PWR”(питание). 

• Отключите кабель питания, затем повторно 
подключите его к приемнику. 

• Если кабель питания поврежден, обратитесь к 
продавцу оборудования для приобретения 
нового кабеля. 
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Слот 3 приемника 
выключен. 

1. Соедините компьютер и приемник (см. раздел 
“Установление соединения через RS232” на 
стр. 2-12). 

2. Выберите вкладку Configuration >Receiver > 
General. 

3. В области Turn on/off Slots выставьте флажок 
Slot 3 (B) 

Устройства 
находятся вне 
радиуса действия 
радиоканала. 

• Проверьте,  находятся ли Ваши устройства в 
пределах радиуса действия Bluetooth.  

• Переместите устройства в зону уверенного 
приема.  

Отказ. 

Иконка модуля Bluetooth приемника видна на экране компьютера, но 
соединение с приемником не устанавливается. 

Причина.  Способ устранения. 

Возможно, 
параметры 
безопасности 
устройств 
отличаются. 

• Убедитесь, что устройства, оснащенные 
Bluetooth, используют одинаковые параметры 
безопасности. 

• Подробности об изменении параметров 
безопасности см. разделе “Настройка модуля 
Bluetooth” на стр. 2-41, особое внимание 
обратите на рис. 2-34.  

Установки модуля 
Bluetooth были 
изменены. 

1. Если Вы изменили параметры настройки 
модуля Bluetooth, удалите его из перечня 
обнаруженных устройств, с помощью 
программы управления каналом Bluetooth 
(прилагается к устройству, используемому для 
организации канала связи Bluetooth). 

2. Повторите поиск. 
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Отказы радиомодема 
Ниже перечислены наиболее часто встречающиеся отказы радиомодема и 
способы из устранения. 
 
Отказ. 

Для УКВ радиомодемов: светодиод RX вспыхивает красным цветом.  

Причина. Способ устранения. 

Обнаружена неисправность. 

• Проверьте отсутствие повреждений 
антенны радиомодема. Обратитесь к 
продавцу оборудования для замены 
антенны. 

• Проверьте надежность и правильность 
подключения антенны радиомодема к 
разъему на защитном кожухе антенны. 

• Отодвиньте антенну дальше от 
проводящих предметов (крупных 
металлических деталей).  

Поврежден кабель. 
• Замените кабель на исправный. 

• Обратитесь к продавцу для замены 
кабеля. 

Отказ. 

Для GSM модемов: светодиод мигает оранжевым цветом.  

Причина. Способ устранения. 

Подвижная станция 
использует неправильный 
PIN код или PIN код не был 
введен, а эту SIM-карту 
можно использовать только 
после ввода PIN-кода. 

1. В программе TopSURV, выберите 
пункт меню Job > Config > Survey. 

2. Щелкните на кнопке «…» 
(Продолжить) и нажмите Next 
(Следующий), чтобы перейти к окну 
настройки радиомодема станции. 

3. Щелкните на кнопке Configure GSM. 
4. Введите PIN-код SIM-карты и 

щелкните на кнопке ОК  
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Для заметок: 
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Приложение A 
Технические 
характеристики 
Это изделие производства фирмы TPS является 20-и канальным GPS-
приемником со встроенным УКВ радиомодемом фирмы TPS, модулем 
беспроводной технологии связи Bluetooth и опциональным GSM модулем. 
Изделие выполнено в прочном алюминиевом корпусе, на котором 
размещен MINTER и разъемы для подключения кабелей. 

 ПРИМЕЧАНИЕ 

Эксплуатационные характеристики даны для следующих 
условий наблюдения: приемник отслеживает не менее 6 
спутников GPS на углах возвышения не менее 15 градусов, 
выполнены все рекомендованные в этом руководстве 
процедуры. 

 ПРИМЕЧАНИЕ 

Допускается ухудшение эксплуатационных характеристик 
в условиях высокой многолучевости, при высоком значении 
геометрического фактора (PDOP), а также в периоды 
повышенной активности ионосферы. 

 ПРИМЕЧАНИЕ 

Используйте дополнительные процедуры контроля 
качества измерений при производстве работ в условиях 
высокой многолучевости и под густой листвой. 
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Технические характеристики 
приемника 
В последующих разделах приводятся характеристики приемника и его 
встроенных компонентов. 

Общие характеристики 
В таблице А-1 перечислены общие характеристики приемника. 

Таблица A-1. Общие характеристики приемника 

Конструктивное исполнение. 

Корпус. Влагозащищенный алюминиевый экструдированный 
профиль,. 

Цвет. Желтый и серый цвета фирмы Topcon 
Габаритные размеры. Ширина:158,5 Высота:113 х Глубина: 173 мм 
Масса. 1,78 кг. 
Антенна. Внутренняя. 
Батарея. Две внутренних. 
Контроллер. Внешний. 
Крепление. 5/8 – 11. 
Уплотнение. Силиконовое. 

Кнопки. 

Три кнопки: 
Power (питание) – On/Off (Вкл./Выкл.) 
FN (Функциональная) – начало/конец записи 
данных; переключение информационных режимов 
отображения. 
RESET (Перезапуск) – перезагрузка приемника. 

Светодиоды. 

Четыре светодиода: 
STAT – состояние спутников и приемника. 
REC – состояние записи и данных. 
BATT – состояние батарей. 
RX – состояние модема. 

Устойчивость к внешним воздействиям. 

Рабочая температура. От -30 до +50 градусов Цельсия (с батареями) 
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Таблица А-1. Общие характеристики приемника (продолжение). 

Температура хранения. От -20 до +35 градусов Цельсия (с батареями). 

Влажность 95% 

Питание. 

Внутренняя батарея. Li-Ion (Литиевая,  4000мА-час, 7,4 В; 2 батареи 
несъемные 

Размеры батарей [мм]. 132 х 35 х 18 

Масса батарей [г]. 165 (1 батарея) 

Время работы. 

~10 часов при мощности передачи УКВ модема 1 Вт
~7 часов при мощности передаче УКВ модема 2 Вт 
~16 часов при работе УКВ модема на прием 
~13-15 часов GSM/GPRS (GSM 900), непрерывный 
вызов. 
~14-15 часов GSM/GPRS (GSM 850), непрерывный 
вызов. 
~13-15 часов GSM/GPRS (DCS 1800), непрерывный 
вызов. 
~13-15 часов GSM/GPRS (PCS 1900), непрерывный 
вызов. 
18 часов при выключенном радиомодеме. 

Внешнее питание. 1 порт. 

Входное напряжение. 
От 6 до 28 В пост. тока (для работы) 
От 9 до 28 В пост. тока (при зарядке батарей) 
Максимальный зарядный ток <= 2 А 

Мощность потребления. 

8,3 Вт при мощности передачи УКВ модема 2 Вт  
6 Вт при мощности передачи УКВ модема 1 Вт  
3,7 Вт при работе УКВ модема на прием 
от 4 до 4,6 Вт GSM/GPRS (GSM 900), непрерывный 
вызов. 
от 4 до 4,4 Вт GSM/GPRS (GSM 850), непрерывный 
вызов. 
от 4 до 4,5 Вт GSM/GPRS (DCS 1800), непрерывный 
вызов. 
от 4 до 4,5 Вт GSM/GPRS (PCS 1900), непрерывный 
вызов. 
3,3Вт при выключенном радиомодеме. 

Зарядка батарей. 

Подключить сетевой адаптер для зарядки 
внутренних батарей. 
Возможна зарядка при подключении к внешней 
батарее. 
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Таблица А-1. Общие характеристики приемника (продолжение). 

Время зарядки. ~ 8 часов до полного заряда 
~ 7 часов до 90% полного заряда 

На печатной плате 
приемника. 

Встроенная батарея для сохранения времени и данных 
альманаха; срок службы не менее 10 лет.  

Обмен данными. 

Порты связи. Два высокоскоростных последовательных RS232 порта (A 
и D), USB порт, и внутренний порт для Bluetooth (порт В).   

Характеристики 
портов. 

Порты A и D 
Скорость передачи данных [Бод]: 460800, 

230400,115200 (начальная установка), 57600, 38400, 
19200, 9600, 4800, 2400,1200, 600, 300. 

Квитирование: RTS/CTS 
Размер слова: 7 и 8 (начальная установка). 
Стоп-биты: 1 (начальная установка), 2 
Четность: отсутствует (начальная установка), проверка 
на четность, проверка на нечетность.  

Bluetooth порт  
в наличии. 

USB порт 
Версия 1.1. 

Разъемы. Антенна модема – BNC, разъем дополнительной антенны 
(опция) – TNC, PWR, USB. 

MINTER. Светодиоды – 4 шт. 
Кнопки – 3 шт. 

Типы и характеристики данных. 

 

Темп обновления до 20 Гц для местоопределения и 
данных измерений (фаза коду и фазе несущей). 
Точность измерения по фазе кода 10 см, по фазе 
несущей 0,1 мм. 
Прием/выдача дифференциальных поправок RTCM104 
версий 2.1,2.2,2.3 и 3.0. 
Использование дифференциальных поправок RTCM от 
нескольких базовых станций. 
Модели геоида и магнитного склонения. 
Встроенный алгоритм контроля целостности RAIM. 
Поддержка дополнительных систем координат. 
Выдача координат в проекции на плоскость. 
Поддержка CMR и CMR+. 



Технические характеристики приемника 

P/N 7010-0713 A-5 

Таблица А-1. Общие характеристики приемника (продолжение). 

Технологические решения. 

 

Co-op слежение. 
Отслеживание слабых сигналов. 
Дополнительное подавление 
многолучевости. 
Совместимость с WAAS. 
Регулируемые параметры PLL и DLL. 

NMEA. 

Версия NMEA (выход).  2.1, 2.2, 2.3 и 3.0. 

Поддерживаемые типы 
сообщений. 

GGA, GLL, GNS, GRS, GSA, GST, GSV, HDT, 
RMC, VTG, ZDA, ROT, GMP. 

Период выдачи. 1 Гц (стандарт), 5 Гц, 10 Гц, 20 Гц (опции) 

DGPS 
Формат 
дифференциальных 
поправок. 

RTCM SC104 версий 2.1, 2.2, 2.3 и 3.0 

Типы RTCM сообщений. 1, 3, 9, 31, 32, 34; по выбору пользователя. 
Частота 
местоопределений. 1 Гц (стандарт), 5 Гц, 10 Гц, 20 Гц (опции). 

Частота вывода 
дифференциальных 
поправок. 

1 Гц (стандарт), 5 Гц, 10 Гц, 20 Гц (опции). 

Минимальный угол 
возвышения. 

От 0 до 90 градусов (устанавливается 
независимо от аналогичного параметра для 
записи данных). 

Дифференциальных 
поправки от нескольких 
базовых станций. 

Режим выбора дифференциальных 
поправок: ближайший, смешанный, 
наилучший (опция). 

RTK 

Формат поправок. CMR2/CMR+ (совместим с Trimble), 
RTCM SC104 Вер.2.2, 2.3, 3.0. 

Тип RTCM сообщений. 3, 18, 19, 20, 21, 22; по выбору пользователя.
Разрешение 
неоднозначности. OTF (L1, L1/L2). 

Длина базовой линии До 50 км в утреннее и вечернее время; 
До 32 км днем. 
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Таблица А-1. Общие характеристики приемника (продолжение) 

Время инициализации. 
От 5 секунд до 10 минут в зависимости от 
длины базовой линии и условий 
многолучевости.  

Частота выдачи 
CMR/RTCM поправок. 1 Гц (стандарт), 5 Гц, 10 Гц, 20 Гц (опция). 

Минимальный угол 
возвышения. 

От 0 до 90 градусов (устанавливается 
независимо от аналогичного параметра 
для записи данных). 

Режимы 
местоопределений. 

С задержкой (синхронный) 
Экстраполяционный (асинхронный). 

Темп местоопределений. 1 Гц (стандарт), 5 Гц, 10 Гц, 20 Гц (опции). 

Латентность 
местоопределения. 

Режим с задержкой – от 20 мс до 20 с (в 
зависимости от латентности 
дифференциальных поправок от базовой 
станции) 
Экстраполяционный режим– от 20 до 30 мс.

Запись измерительных 
данных. 

Приемник может записывать 
измерительные данные с темпом, 
отличным от темпа местоопределений 
RTK. 

Признаки состояния. 

Разрешение неоднозначности Fixed, Float, 
DOP, состояние линии связи, латентность 
модема, наблюдаемые спутники, 
доверительный интервал. 

Выдаваемые результаты. RTK-координаты, HRMS, VRMS, матрица 
ковариации. 

Уровень доверительного 
интервала при разрешении 
неоднозначности фазы. 

Выбираемые пороги: 
Низкий: 95%, Средний: 99,5%, Высокий: 
99,9%   

Режимы съемки 

Подвижная или базовая 
станция 

Статический; 
Кинематический (Stop and Go); 
RTK (кинематический в реальном 
времени); 
DGPS (дифференциальный по коду); 
WAAS/EGNOS DGPS. 

Точность дифференциальных режимов(L – длина базовой линии 
[м]) 
Static (Статический), Fast 
Static (быстрый 
статический), L1+L2. 

В плане:     3 мм+0,5*10-6 * L; 
По высоте: 5 мм+0,5*10-6 * L; 
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Таблица А-1. Общие характеристики приемника (продолжение). 

RTK(Кинематический в 
реальном времени), L1+L2 

В плане:     10 мм+0,5*10-6 * L; 
По высоте: 15 мм+0,5*10-6 * L; 

DGPS (дифференциальный 
по коду) 

Постобработка: типично 0,3 м 
RTCM (реальное время): лучше 0,5 м 

“Холодный” старт 
“Теплый старт” 
Восстановление слежения 

< 60 с 
< 10 с  
< 1 с 

 
 

Технические характеристики платы 
спутникового приемника 
В таблице А-2 приведены общие характеристики платы спутникового 
приемника. 

Таблица А-2. Общие характеристики платы спутникового приемника 

Тип приемника (устанавливается загрузкой OAF) 

Внутренняя плата: 
Euro-112T 
(HGGDT) 

G: GPS L1 
GD: GPS L1/L2 
GG: GPS/ГЛОНАСС L1 
GGD: GPS/ГЛОНАСС L1/L2  

Тип аппаратуры: 
зависит от страны, региона и 
назначения прибора. 

С УКВ модемом 410-430 МГц 
С УКВ модемом 430-450 МГц  
С УКВ модемом 450-470 МГц 
С УКВ модемом 410-430 МГц +GSM 
С УКВ модемом 430-450 МГц +GSM 
С УКВ модемом 450-470 МГц +GSM 

Характеристики слежения. 

Стандартные каналы. 

20 каналов (G, GG, GD, GGD) 
L1 GPS, L1/L2 GPS, L1 ГЛОНАСС, L1 
GPS+L1 ГЛОНАСС, WAAS/EGNOS, P-
код и по фазе несущей 

Дополнительно. Cindrella days (см. стр. А-8). 

Отслеживаемые сигналы. GPS/ГЛОНАСС, L1/L2 C/A, P-код и фаза 
несущей, WAAS/EGNOS  

Функции слежения. 

Подавление многолучевости. По коду и фазе несущей. 
Настраиваемые параметры 
PLL/DLL. Полоса частот и порядок фильтра. 
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Таблица А-2. Общие характеристики GPS-платы (продолжение) 

Настраиваемые параметры 
петли слежения Co-op. 

Использовать / не использовать, 
статический режим, ширина полосы 
каждого узла ФАПЧ, ширина полосы 
общего узла ФАПЧ. 

Интервал сглаживания. Измерений кода и фазы несущей. 

WAAS/EGNOS WAAS (опция) 
EGNOS (опция) 

Типы и характеристики данных. 
Поддерживаемые форматы 
данных. TPS, NMEA, RTCM, CMR, BINEX 

Характеристики. 

Темп обновления до 20 Гц для 
местоопределения и данных измерений 
(фаза коду и фазе несущей). 
Точность измерения по фазе кода 10 см, и 
0,1 мм по фазе несущей. 
Прием/выдача дифференциальных поправок 
RTCM104 версий 2.1,2.2,2.3 и 3.0. 
Использование дифференциальных поправок 
RTCM от нескольких базовых станций. 
Модели геоида и магнитного склонения. 
Встроенный алгоритм контроля целостности 
RAIM  
Поддержка дополнительных систем 
координат. 
Выдача координат в проекции на плоскость. 
Поддержка CMR и CMR+. 

Память. 

Внутренняя память. Карта памяти Compact Flash (несъемная). 

Емкость памяти. Стандартно – 0 Мб. 
Опция - от 1 до 128 Мб. 

Продолжительность записи. 53 часа (8 Мб, 15 сек, L1/L2, 7 спутников). 

Интервал записи. От 0,05 до 86400 секунд, в зависимости от 
приобретенных опций. 

Cindrella days - опция, которая превращает одночастотный GPS-приемник 
в двухчастотный GPS+ГЛОНАСС приемник на 24 часа каждый вторник, 
начиная с полуночи по шкале времени GPS. За более подробной 
информацией и конкретными датами дней Cindrella обратитесь на 
интернет-сайт Topcon.  
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Технические характеристики 
модуля Bluetooth 
В таблице А-3 перечислены общие характеристики модуля беспроводной 
технологии связи Bluetooth. 

Таблица А-3. Характеристики модуля Bluetooth 

Тип. Класс 2  
Классы обслуживания. Разнообразные. 
Поддерживаемые профили. LM, L2CAP, SDP, PPP. 
Код частоты страны. Северная Америка и Европа. 

 

Технические характеристики 
встроенного УКВ модема TPS  
В таблице А-4 перечислены общие характеристики встроенного УКВ 
модема фирмы TPS. 

Таблица А-4. Характеристики встроенного УКВ модема фирмы TPS 

Общие. 

Частотный диапазон 
(зависит от страны, региона 
и назначения прибора). 

410-430 МГц 
430-450 МГц  
450-470 МГц 

Шаг сетки каналов. 12,5 кГц / 25 кГц  
Стабильность несущей 
частоты. 2,5 ppm. 

Стабильность мощности ВЧ 
передачи. +1 дБ/-2дБ 

Скорость передачи данных 
по последовательному 
интерфейсу. 

38400 бит/сек максимум. 

Скорость передачи по 
эфиру. 

19200 или 9600 бит/сек (4-х уровневая 
FSK) 
9600 или 4800 бит/сек (GMSK)  

Протоколы передачи. С коммутацией пакетов, быстрый 
асинхронный. 

Кодирование с 
упреждающим 
исправлением ошибок (FEC) 

Возможно применение. 
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Таблица А-4. Характеристики встроенного УКВ модема фирмы TPS (продолжение) 

Модуляция. 

GMSK с BT 0,3; 0,5 (при скорости линии 
передачи данных 4800, 9600 бит/сек); 
4-level FSK (при скорости линии передачи 
данных 9600,19200 бит/сек); 

Режим приема/передачи. Полудуплексный. 

Последовательный порт. Два RS-232 (данные и команды). 

Передатчик. 

ВЧ мощность передачи. 

0,01 Вт (+10 дБм), 0,02 Вт (+13 дБм), 0,05 
Вт (+17 дБм), 0, 1 Вт (+20 дБм), 0,25 Вт 
(+24 дБм), 0,5 Вт (+27 дБм),  
1 Вт (+30 дБм), 2 Вт (+33 дБм) 

Стабильность мощности ВЧ 
передачи. +2дБ/-3дБ. 

Приемник. 

Чувствительность. - 116…-110 дБм (BER<10-3). 

Селективность смежного 
канала. 

>-60 дБ @ 12,5 кГц. 
> -70 дБ @ 25 кГц. 

 

Технические характеристики 
опционального модуля GSM/GPRS 
В таблице А-5 перечислены внутренние общие характеристики 
встроенного опционально поставляемого модуля GSM/GPRS.  

Таблица А-5. Характеристики модуля GSM/GPRS 

Поддерживаемые 
стандарты. 

EGSM: 900/1800 МГц; 
GSM: 850/1900 МГц.  

ВЧ мощность передачи. 0,6 Вт (850 МГц); 2 Вт (900 МГц); 1 Вт 
(1800/1900 МГц) 

GPRS. 

Мульти-слот класс 8 (4 down; 1 up); 
Максимальный BR 85,6 Кбит/сек; 
GSM 07.10 мультиплексный протокол 
класса В; 
Схема кодирования CS1-CS4; 

CSD. Максимальная скорость14,4 Кбит/сек.  
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Таблица А-5. Характеристики модуля GSM/GPRS (продолжение) 

SMS MO/MT текст  и PDU режимы  
Cell broadcast (прием служебного канала). 

 

Технические характеристики 
разъемов 
Далее приводятся технические характеристики разъемов, установленных 
на корпусе приемника HiPer XT. 

ВЧ разъем радиомодема 
Разъем УКВ радиомодема фирмы TPS (Таблица А-6) – BNC гнездовой. 

Таблица А-6. Описание УКВ соединителя модема 

Тип Название 
сигнала Направление Примечание 

BNC Вход/Выход 
модема Вход/Выход 

Используется для 
подсоединения антенны 
радиомодема 

 

Разъем питания 
Разъем питания (см. рис. А-1) - герметичный пятиштырьковый гнездовой 
фирмы ODU p/n G80F1C-T05QF00-0000. 

 
Рисунок А-1. Разъем питания 
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В таблице А-7 приведено описание разъема питания. 

Таблица А-7. Описание разъема питания 

Штырек Сигнал Направление Примечание 

1 Power_INP (Питание 
Вход). Силовой 6 - 28 В постоянного 

тока 

2 Power_INP (Питание 
Вход). Силовой 6 - 28 В постоянного 

тока 

3 Power_GND (Питание 
Общий). Силовой Общий 

4 Power_GND (Питание 
Общий). Силовой Общий 

5   Не используется 
 

Разъем последовательного порта 
RS-232 
Разъемы установлены для интерфейсных портов А и D. Разъем RS232 
(см. рис. А-2) - герметичный семиштырьковый гнездовой фирмы ODU p/n 
G80F1C-T07QC00-0000. 

 
Рисунок. А-2. Разъем RS232. 

В таблице А-8 приведено описание разъема RS232. 
 

Таблица А-8. Описание разъема RS232. 

Штырек Сигнал Направление Примечание 

1 Питание Выход  Силовой Выход напряжения 
питания 

2 Общий  Сигнальный общий. 

3 СTS Вход Передача возможна. 
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Таблица А-8. Описание разъема RS232 (продолжение). 

Штырек Сигнал Направление Примечание 

4 RTS Выход Запрос на передачу. 

5 RXD  Вход Прием данных. 

6 TXD Выход Передача данных. 

7   Не используется 
 

Разъем USB 
Разъем питания (см. рис. А-3) - герметичный пятиштырьковый гнездовой 
фирмы ODU p/n G80F1C-T05QF00-0000. 

 
Рисунок А-3. Разъем USB для опции GGD 

В таблице А-9 приведено описание разъема USB. 

Таблица А-9. Описание разъема USB 

Штырек Сигнал Направление Примечание 

1   Не используется  

2 USB_PWR Силовой Шина питания USB 

3 GND   Земля 

4 USB D+ Вход/Выход Данные 

5 USB D- Вход/Выход Данные 
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Для заметок: 
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Приложение B 
Меры безопасности 
 

Предупреждения общего 
характера 
 

 ПРИМЕЧАНИЕ
Санитарно-гигиенические нормы эксплуатации 
радиосредств выполняются на удалении более 25 см от 
антенны радиомодема. 

 
ПРЕДУПРЕЖДЕНИЕ

Приемники TPS предназначены для геодезической 
съемки и относящихся к ней задач (например, 
определения координат, измерение расстояний, углов и 
глубин и записи результатов таких измерений). Эти 
изделия не должны быть использованы: 
− Без тщательного изучения и четкого понимания этого 
Руководства. 

− После отключения систем безопасности или внесения  
изменений в изделие. 

− С нештатными принадлежностями. 
− Без соблюдения соответствующих мер безопасности 
при проведении работ. 

− Вопреки установленным законам, нормам и правилам. 
 

 
ОПАСНОСТЬ 

TPS приемники нельзя использовать в опасных 
окружающих условиях. Использование приемника под 
дождем и снегом допустимо лишь в течение 
ограниченного времени.
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Правила эксплуатации 
встроенных батарей 
 

 
ОПАСНОСТЬ 

Ни в коем случае не пытайтесь открыть корпус прибора 
или заменить батареи! Литиевые батареи могут 
взорваться при неправильном обращении. 

 
ОПАСНОСТЬ 

Ни в коем случае не сжигайте и не нагревайте блок 
батарей выше 100 градусов по Цельсию. Перегрев 
может вызвать серьезные повреждения и взрыв. 

 
ПРЕДУПРЕЖДЕНИЕ

Замена внутренних батарей конечными пользователями 
или не уполномоченными производителем техниками 
приводит к отмене гарантийных обязательств на 
приемник. 

− Не пытайтесь открыть батарейный блок или заменить 
его. 

− Не разбирайте батарейный блок. 
− Не производите зарядку батарей в условиях, 
отличных от указанных в Руководстве. 

− Не используйте зарядное устройство, отличное от 
того, что указано в Руководстве. 

− Избегайте короткого замыкания. 
− Не разрушайте и не изменяйте конструкцию. 
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Предупреждения по 
применению  
 
 

 ОСТОРОЖНО 

Если это изделие было подвергнуто ударному 
воздействию, модифицировано, перевозилось без 
надлежащей упаковки или с ним обращались без 
должной аккуратности, измерения могут содержать 
погрешности. 
Пользователь должен периодически поверять изделие 
для того, чтобы удостовериться в том, что 
точность проводимых им измерений соответствует 
заявленным техническим характеристикам.  
Немедленно информируйте TPS о неправильной работе 
изделия. 

 ОСТОРОЖНО 

Ремонт и обслуживание изделия должны проводиться 
исключительно в сервисных центрах, 
сертифицированных TPS. 
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Для заметок: 
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Приложение C 
Использование УКВ 
радиомодема 

 ПРИМЕЧАНИЕ 
Использование радиостанций УКВ диапазона требует 
наличия разрешения на использование радиочастот. 
Самовольная эксплуатация радиоэлектронных средств 
влечет предупреждение или наложение 
административного штрафа с конфискацией конечного 
оборудования или без таковой. Порядок рассмотрения 
материалов и принятия решения о выделении полос 
радиочастот и присвоении (назначении) радиочастот или 
радиочастотных каналов в пределах выделенных полос 
радиочастот устанавливается и публикуется 
государственной комиссией по радиочастотам. 

При проведении съемки в режиме RTK, УКВ радиомодем является  
наиболее популярным средством для организации канала передачи 
данных между базовой и подвижной станциями. Следует знать сильные и 
слабые стороны этой техники с тем, чтобы пользоваться ею максимально 
эффективно. 
Радиус действия УКВ-связи определяется уровнем сигнала в точке 
приема. 
1. Дальность действия системы в значительной степени зависит от 

местных условий. 
Рельеф, местная электромагнитная обстановка (действующие системы 
радиосвязи), а также погодные условия оказывают влияние на УКВ 
связь. 

2. Дальность действия системы возрастет при настройке антенны 
базовой станции одним из следующих способов: 
• Убедитесь в том, что батарея передатчика базовой станции 

полностью заряжена. 
• Для увеличения дальности действия канала связи используйте 

направленные антенны и/или репитеры. Направленные антенны 
концентрируют энергию сигнала в пределах более узкой зоны, что 
существенно увеличивает дальность действия системы. 

• Изучите список предлагаемых TPS приспособлений для 
увеличения высоты радиоантенны базовой станции. 
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Для заметок: 
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Приложение D 
Гарантийные 
обязательства 
Лазерные и электронные геодезические инструменты компании TPS 
гарантированы от использования дефектных материалов и 
работоспособны при эксплуатации согласно этому Руководству. Гарантия 
действительна в течение периода времени, указанного на гарантийном 
талоне, приложенному к изделию, приобретенному у авторизированного 
дилера TPS. 1 
В течение гарантийного периода TPS, по своему выбору, бесплатно 
восстановит или заменит неисправное оборудование. Запасные части и 
изделия будут заменены новыми или отремонтированы на основании 
обмена на неисправное оборудование. Эта ограниченная гарантия не 
распространяется на услуги по восстановлению изделия, неисправного из-
за несчастного случая, стихийного бедствия, неправильной эксплуатации 
или несанкционированной модификации. 
Гарантийное обслуживание может быть получено от уполномоченного на 
производство ремонта представителя TPS. Если неисправное изделие 
поставляется почтой, покупатель обязуется застраховать изделие или 
принимает риск потери или повреждения во время транспортировки. При 
пересылке покупатель должен использовать оригинальную упаковку или 
эквивалентную. К направляемому в гарантийный ремонт изделию следует 
приложить письмо, описывающее отказ и/или дефект изделия. 
TPS ни при каких условиях не принимает на себя обязательств возмещать 
убытки или издержки, в том числе упущенную выгоду, потери денежных 
средств, или другие прямые или косвенные убытки, могущие возникнуть от 
использования или невозможности использования изделия. 
 
 
 
 
 
 
 
1. Гарантия на батареи, зарядные устройства и кабели производства 
Topcon составляет 90 дней. 
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Для заметок: 
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